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Terms and Conditions

The recipient agrees to the following conditions:

Use and Distribution Restrictions
The recipient may make sufficient backup copies of the program to protect his or
her site or organization against loss of the program. The recipient may use the
program, by copying of disks or by installation on a local area network or
mainframe, at one site and within one organization. For purposes of this
restriction, a “site” means any one street address, and includes mobile response
units assigned to that site for which the recipient is responsible.

Temporary classroom installation of no more than 25 copies is allowed for a
period not to exceed the normal course of instruction. The recipient shall not
distribute, electronically or by any other means, any portion of MARPLOT to
individuals other than those included in the site or organization restrictions
defined above or to any other organizations not part of the recipient
organization.

Limitation of Liability
The United States Government has used its best efforts to deliver complete data
incorporated into MARPLOT and its associated map files. Nevertheless, the
United States Government does not warrant accuracy or completeness, is not
responsible for errors and omissions, and is not liable for any direct, indirect, or
consequential damages flowing from the recipient’s use of MARPLOT.

The MARPLOT software is distributed “as is” and the United States Government
does not make any warranty claims, either express or implied, with respect to the
MARPLOT software, its quality, accuracy, completeness, performance,
merchantability, or fitness for any intended purpose.

Indemnification
The recipient shall indemnify and save harmless the United States and its agents
and employees against any and all loss, damage, claim, or liability whatsoever,
due to personal injury or death, or damage to property of others directly or
indirectly due to the use by the recipient of MARPLOT, or any other act or
omission of the recipient.

Maintenance
MARPLOT® is a trademark of the U.S. Government. Apple® and Macintosh™
are trademarks of Apple Computer, Inc. Microsoft® and Windows™ are
trademarks of Microsoft Corporation.
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1   Welcome to MARPLOT

1.1  About this manual

Welcome to MARPLOT 3.3 for Windows and Macintosh.

This manual contains some information with which all users of MARPLOT
should be familiar, and some information that is directed only to the
administrator (system manager) of a MARPLOT system and other advanced
MARPLOT users.

All users should read section 1.2 to learn the basic MARPLOT concepts. New
users will want to read through Chapter 3 to learn how to start MARPLOT and
to get an overview of its basic functions. Chapter 4 is a detailed reference to all
MARPLOT functions. You may want to skim this chapter now to get a feel for
the range of MARPLOT functions, and return to it as you need specific
information about individual functions. Once you have worked through Chapter
3 and are familiar with the basics, you can look at the more detailed examples in
Chapter 5. Chapter 6 contains a visual guide to MARPLOT, showing the different
parts of MARPLOT’s various displays and dialog boxes. Some typical pitfalls
and their solutions are given in Chapter 7.

If you are the administrator (system manager) of your MARPLOT system, you
should read Chapter 2 to learn how to install MARPLOT and update your data
from an earlier version of MARPLOT. This chapter also gives important
information about adding maps to your system and setting up a multi-user
system.

Other sources of MARPLOT information

This manual is one of three important sources of information about MARPLOT.
The other sources are the on-line documentation and the MARPLOT Technical
Documentation.

You can access the on-line documentation directly on the computer screen as you
use MARPLOT. By using the “Help” buttons on many of MARPLOT’s dialog
boxes, you can get immediate information about the function you are currently
performing.

The Technical Documentation gives details about the formats of the various files
used by MARPLOT, including the MARPLOT Import/Export (MIE) format. It
also contains a list of IAC messages MARPLOT sends and receives.
1.2  About MARPLOT

MARPLOT (Mapping Application for Response, Planning, and Local
Operational Tasks) is a general-purpose mapping application program. It allows
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you to create, view, and modify maps quickly and easily. It also allows you to
link objects on your computer maps to data in other programs.

Below is a description of each of the key MARPLOT concepts.

1.2.1   Objects

Objects are the basic map elements that MARPLOT draws and lets you
manipulate. There are seven different types of objects: points (symbols),
rectangles, circles, polygons, polylines, text labels, and picture objects. You might
use a point object to mark the location of a facility or accident site. Polylines are
used to represent things like roads and streams. Polygons are used to represent
things like parks or water bodies. MARPLOT provides functions for creating,
examining, and modifying each type of object. The objects are organized into
layers and maps.

1.2.2   Layers

A layer is a category of objects. For instance, a layer called “Roads” might
contain a large number of polyline objects representing roads. A layer called
“Facilities” might contain point objects representing the locations of facilities.
Although a given layer often contains only one type of object, this is not
necessarily the case. For instance, a layer called “Water” might contain some
polyline objects representing streams and some polygon objects representing
larger water bodies. It is useful to organize objects into layers because then you
can operate on the objects in a given layer as a group. For instance, you might
choose to hide or show all of the “Roads.”  Or you might want to select all or
some of the “Facilities” to get information about them. It is possible to move an
object from one layer to another, but an object can be on only one layer at a time.

1.2.3   Maps

A map is a folder (directory) on your disk that contains several files. These files
contain the objects on the map. A map folder (directory) is often located in the
same folder (directory) as the MARPLOT application program, but can be
located anywhere on any of your disk drives. Often, a map covers the area of a
single U.S. county, but maps can be much smaller or much larger than that. It is
possible to expand maps by adding new objects to them, or shrink them by
removing objects.

You can have any number of maps in use at a given time. If you use MARPLOT
to view an area that intersects with more than one map, all maps in the displayed
area are drawn simultaneously on the screen. In fact, it is possible for the
geographical areas covered by two or more different maps to overlap. All of the
maps that MARPLOT is aware of are always “present,” and there is no need to
“close” one map before opening another to view it. However, it is possible to put
a map “out of use” so that it is not drawn on the screen.
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In most cases, you do not need to be concerned with the fact that the image
shown on the screen is actually a composite of two or more MARPLOT maps.
For convenience, when the distinction between maps is not important, we often
refer to the collection of maps shown on the screen simply as “the map.”

1.2.4   Relationship between maps and layers

We have said that layers contain objects, but also that maps contain objects. The
truth is that each MARPLOT object is on a certain layer and on a certain map. For
instance, you can have a road object on the “Roads” layer of the “LA County”
map; or you can have a river object on the “Water” layer of the “Orange County”
map; or again, you can have a park object on the “Miscellaneous” layer of the
“Orange County” map.

In most cases, you will think primarily in terms of layers and secondarily in
terms of maps. For instance, suppose you are using MARPLOT’s search function
to find “Park Ave.”  You know that Park Ave. will be found on the Roads layer,
so you would choose to limit the search to that layer. As for the map(s) to be
searched, however, you can generally specify simply the “Map(s) in View.”
Even if you have more than one map, it is most common to search for an object
on the map that you are currently looking at.

The main point to remember is that, while it’s true that each object is on a certain
layer which in turn is part of a certain map, for the most part when using
MARPLOT you can think in terms of layers (in terms of the “type” of object) and
not worry about the fact that there is more than one map. However, for certain
operations, such as when searching for a road when several maps are in view,
you can greatly increase efficiency by specifying a particular map whenever
possible.

1.2.5   Views

MARPLOT provides a number of tools for navigating around your maps. You
can zoom in and out, shift the view in any direction, or change the view to show
a particular object or group of objects.

You can also save the area you are looking at, along with a miniature image of
the map window. The saved view can be used in a number of different ways.
You can return to it at a later time. You can use it as a reference view to help with
future navigation. You can choose a saved view to be the entry view, the view
MARPLOT automatically shows when it starts. Also, if your MARPLOT system
is multi-user, you can choose whether a given view that you save is for your use
only, or is meant to be shared with other users of the system.

1.2.6   The Search Collection and the selected objects

MARPLOT provides a flexible mechanism for searching for objects (described
more fully in section 4.5.1). You can search for objects by name or by their
position relative to other objects. You can also limit the search to certain layers



Chapter 1: Welcome to MARPLOT

4

and/or certain maps. When a search is performed, the objects matching the
criteria you have specified are put into a list called the Search Collection. From the
Search Collection, you can choose an object and display it on the map, or look for
address ranges and intersections of certain types of objects. This Search
Collection list is saved until you explicitly change it. This allows you to return to
the list, to show another object, for instance. You can also save a Search
Collection to the disk for use at a later time.

In addition to those in the Search Collection, another important set of objects is
those that are currently selected. Every time you click on an object on the screen,
MARPLOT selects that object by drawing small red squares around it and
displays its name and other information about it in the bottom of the window. It
is possible to select more than one object at a time. The functions in the Objects
menu apply to the selected object or objects. For instance, when you choose an
item from the Color submenu, you change the color of all of the selected objects.

You can copy the objects that are currently selected into the Search Collection.
Going the other way, you can select all of the objects in the Search Collection.
Between the Search Collection and the selected objects you have a number of
mechanisms for dealing with groups of objects.

1.2.7  Linking objects to data in other programs

MARPLOT contains limited information about each object: the color and other
graphical attributes, the name, the address ranges of most roads, and a few other
pieces of information. Most users are interested in associating MARPLOT objects
with data records in other programs, usually databases. The basic procedure is to
establish a link between an object in MARPLOT and a record in the database,
either through a manual procedure, or by an automated procedure. Once links
have been established, you can select objects in MARPLOT and choose to go to
the associated records in the database. Going the other way, you can select
records in the database and choose to view the associated objects on the map.

The specific mechanism for establishing links depends on the particular database
application you are using with MARPLOT, and the nature of the associated map
data. There are also some differences in this area between the Windows and
Macintosh versions of MARPLOT. However in most cases creating and using
links involves using the Sharing menu in MARPLOT and/or the database
application. Further information about links and the Sharing menu can be found
in section 4.7 and in the documentation for your database application.

1.2.8  Object identification

For the most part, you will identify objects on the map by their name, their layer
and their map. For instance, you may find “Fairfax Ave” on the “Roads” layer of
the “LA County” map. Internally, MARPLOT has a slightly different mechanism
for keeping track of objects: it uses the layer and map name, but, instead of using
the object name, MARPLOT assigns to each object a unique identification
number. For the most part, you need not be aware of this identification number.
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However, it does come into play when importing and exporting objects (see
sections 4.2.2 and 4.2.3) and when linking objects to databases (see section 1.2.7).

When MARPLOT imports an object, and already contains an object with the
given identification number, layer, and map, it (usually) replaces the existing
object with the newly imported one, the idea being that the new one is an
“update” of the old one.

When a link is established between a MARPLOT object and a record in a
database program, the database program keeps track of the link by storing the
layer name, map name, and identification number of the given object.

1.2.9   Administration and user permission

Your MARPLOT system can be set up in either “single-user” or “multi-user”
mode.

In multi-user mode, there is a system administrator who has the ability to give
other users access to the system by giving them a password. The administrator
also chooses whether each user will access MARPLOT with browse-level or edit-
level permission. Users who have browse-level permission can perform most
MARPLOT functions, but cannot access certain functions that have the potential
to damage or delete important map data. Users who have edit-level permission
can access all MARPLOT functions, including those that are potentially
dangerous.

In single-user mode, there are no passwords, and anybody who starts
MARPLOT is given edit-level permission.

In a multi-user system, each user is given a folder (directory) within the USERS
folder, which itself is within the MARPLOT folder. The user’s folder contains
information about the user, the user’s MARPLOT preferences and layer order,
any views the user has saved, and a special “user’s map” that the user can edit,
even if the user does not have edit-level permission.

1.2.10   Some mapping concepts

Scale

Among other obvious differences, computer maps like those in MARPLOT differ
from regular maps on paper in that you can zoom in or out; that is, you can view
them at different scales. When we talk about the scale of a map, we mean the size
of objects on the map relative to the size of those objects in the actual world. For
instance, suppose a certain road is one mile long. If the line representing the road
on the computer monitor is 1 inch long, we say that the scale is “1 inch = 1 mile.”
If we zoom out (show more map area on the screen) such that the line on the
monitor is now half an inch long, we say that the scale is “0.5 inch = 1 mile” or “1
inch = 2 miles.”
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When we talk about one scale being larger than another scale, we mean that the
first scale is “more zoomed in” than the second. For instance, the scale “1 inch = 1
mile” is larger than the scale “1 inch = 2 miles.”

Consider the scale “1 inch = 1 mile.”  We can express this scale without reference
to units such as inches or miles. To do this we note that 1 mile is equal to 5,280
feet and a foot is 12 inches, so there are 5,280 x 12 = 63,360 inches in a mile. We
can write our scale as “1 : 63360” meaning that one inch (or one centimeter or one
whatever) on the map is equal to 63,360 inches (or 63,360 centimeters or 63,360
whatevers) in the actual world.

This gives us two ways to write scales: the “1 inch = 1 mile” format or the
“1 : 63360” format. Another way of indicating scale is to specify how much area
is covered by the entire map being viewed. For instance, we can write “7 mi x 6
mi” to indicate that our computer map is displaying 7 miles across by 6 miles up
and down. If we happen to know that the computer window is 7 inches wide and
6 inches high, then we know our scale is “1 inch = 1 mile.”  Unfortunately, we
don’t usually know the width and height of the window on the screen, especially
since you can change the size of the window whenever you want.

MARPLOT allows you to display the scale in any of the three formats: “1 inch = 1
mile,” “1 : 63360,” or “7 mi x 6 mi.”  You can use whichever you feel most
comfortable with, but remember that the last is not an actual scale unless the
exact size of the window is also specified.

When to show?  When to label?

Certain types of map data are appropriate to display only at certain scales. For
instance, consider the network of roads in a city. When you are viewing the map
at “1 inch = 0.1 mile” or even “1 inch = 3 miles,” it may be useful to see the roads,
although at the latter scale the roads will probably be drawn very close together.
When you change to a scale such as “1 inch = 10 miles,” it doesn’t make sense to
draw the city roads, since they will be so close together on the screen that they
will appear as a solid black mass.

On the other hand, if you have a map of the outlines of the 50 U.S. states, it is
reasonable to view this data at “1 inch = 100 miles” or even at a smaller scale.
However, a much larger scale such as “1 inch = 1 mile” would not be useful for
viewing this data, since, being so far zoomed in, you would only be able to see a
tiny section of state boundary on the screen.

In addition to the question of whether to display certain data at all at certain
scales, there is the question of when certain data should be labeled on the screen;
that is, when should we attempt to draw the names of the roads or the states?
Even at scales such as “1 inch = 1 mile,” when the roads themselves will be
distinguishable, we probably do not want to label the roads, since the names will
crowd each other on the screen and will be illegible. We’ll generally only want to
label roads at scales larger than “1 inch = 0.1 mile.”  On the other hand, states
could be labeled at much smaller scales.
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MARPLOT allows you to specify scale ranges within which each layer should
display. You can also specify the scale at which labels for each layer appear.
These and other scale options are explained in section 4.5.4.

Latitude and Longitude

In everyday conversation, we usually refer to locations by reference to other
known locations. For instance, we say “My house is on the corner of 4th and
Main.”  MARPLOT allows you to find locations similarly by specifying street
intersections or street addresses. However, a more universal method of
specifying locations is to use latitude/longitude coordinates. Latitude is a value
in the range of 90 degrees south (the South Pole) to 90 degrees north (the North
Pole). The equator is at zero degrees latitude. The line of 40 degrees latitude cuts
across the USA from Northern California to New Jersey. Longitude is a value in
the range of 180 degrees west to 180 degrees east. Zero degrees longitude is the
semi-circle that runs from South Pole to the North Pole through Greenwich,
England. The 48 contiguous U.S. states are framed roughly between 67 degrees
west and 125 degrees west.

Any point on the globe can be specified by giving its latitude (how far north or
south) and longitude (how far east or west). For instance, the corner shared by
the U.S. states Utah, Colorado, Arizona, and New Mexico is approximately at 37
degrees north, 109 degrees west.

If more precise measurements are needed, we divide each degree (latitude or
longitude) into 60 minutes, and each minute into 60 seconds. (One minute
latitude  2,000 yds; one minute longitude varies from about 2,000 yds at the
equator to 0 yds at each Pole.)

MARPLOT can display latitude/longitude values in three different ways.

1) As a degree value followed by a decimal degree fraction. For example,
40.250000° represents 40 and 1/4 degrees, which is the same as 40 degrees
and 15 minutes.

2) As a degree-minute-second triplet. For example, 40°25’00’’ represents
40 degrees, 25 minutes and zero seconds. Note that is NOT the same value
as given in (1). 25 minutes is almost half a degree, not a quarter.

3) As a degree-minute pair, where the minutes have a decimal fraction. For
example 40°25.50’ represents 40 degrees and 25.50 (25 and a half) minutes.

1.2.11 The TIGER/Line database and LandView

Most MARPLOT users in the United States will work with one or more
MARPLOT maps that are based on data from the TIGER/Line™ geographical
database, which is maintained by the Bureau of the Census. Each of these maps
covers a single U.S. county or territory.
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LandView is a database application developed by the U.S. Environmental
Protection Agency. It uses map files in the MARPLOT format, with other data
from EPA and Census databases. LandView is distributed on DVD or custom
CD’s containing the LandView software, database information, and TIGER-
derived maps. Because the maps are in the MARPLOT format, MARPLOT users
can use the maps on the LandView dics. See section 2.4.2 for more information
about obtaining MARPLOT maps.

Accuracy of the TIGER/Line database

Map features based on data from the TIGER/Line database contain any errors or
incompleteness present in the version of the TIGER/Line database from which
they were derived. These inaccuracies include things like misspelled street
names, missing or incorrect address ranges, missing or added segments of streets
and other features, and positional (latitude/longitude) inaccuracies.

The geographical data in the TIGER/Line files is derived from various sources,
which themselves have various degrees of positional accuracy. In general, you
should not count on TIGER-derived map features to have better accuracy than
the established National Map Accuracy standards for 1:100,000-scale maps from
the US Geological Survey (approximately +/- 167 feet). You can, however, count
on map features being in the correct location relative to one another (e.g., if a
stream appears to run along the north side of a road, it really is to the north of
the road).

The accuracy of any geographical database depends on several factors. One of
these is the mathematical model of the shape of the earth used when determining
the latitude/longitude coordinates of features within the database. The
coordinates in the current TIGER/Line database are based on the North
American Datum of 1983 (NAD83). A "Datum" includes a mathematical model of
the earth along with a set of measured or calculated control points. Until 1995
TIGER/Line coordinates were based on the North American Datum of 1927
(NAD27), which was defined in terms of modeling and surveying techniques
used in the 1800s. If you have created maps for use with previous versions of
MARPLOT, those maps are also based on NAD27. Coordinates in the NAD83
database can differ from those of the NAD27 database by about 600 meters (656
yards) in certain places. Bear this difference in mind, especially if you choose to
use maps based on one datum along with coordinates based on a different
datum; in such cases, expect that the locations of features may be "off" by up to
several hundred meters (yards).

More information about the TIGER/Line database is available on the
TIGER/Line compact discs.

For more information on NAD27 and NAD83, see The North American Datum of
1983, A Collection of Papers Describing the Planning and Implementation of the
Readjustment of the North American Horizontal Network. American Association for
Geodetic Surveying, Monograph No. 2. ACSM, Falls Church, VA. 49pp.
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Reporting changes to TIGER/Line information

MARPLOT 3.3 allows you to make changes to objects derived from TIGER data,
such as adding missing streets or street segments, or fixing address numbers.
Section 5.4 gives a detailed example of this type of editing.

The Bureau of the Census is interested to learn about such changes, so that they
can be evaluated for inclusion in future versions of the TIGER/Line database.
Please refer to     http://landview.census.gov     for an explanation of how to report
the changes.

Thanks for your help.
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2   Installing and Managing Your MARPLOT
System

2.1  System requirements

MARPLOT uses about 1.5 megabytes (MB) of internal memory (RAM) for itself,
but will take advantage of more memory if it is available. The program and
associated files take about 1.5MB on disk, not including the map files. The
amount of disk space required for maps varies according to the number and size
of maps you use. The maps for United States counties take anywhere from about
0.5MB to about 20MB of disk space. A typical county takes from 5 to 10MB.

For Windows...

MARPLOT requires Windows 3.1 or later. When used with Windows 3.1,
it requires the Win32s system extension, which is included with
MARPLOT and installed as part of the standard installation procedure.

For Macintosh...

MARPLOT requires System 7.0 or later.

2.2  Installation

Step-by-step instructions for installing MARPLOT, on either the Windows or the
Macintosh platform, can be found in Appendix 1. Please look there for
installation instructions.

2.3  Updating from an older version of MARPLOT

MARPLOT 3.3 is completely compatible with MARPLOT 3.0, 3.1, or 3.2. To
update from MARPLOT 3.0, 3.1, or 3.2 to MARPLOT 3.3, you can simply copy
the MARPLOT 3.3 application file into your existing MARPLOT folder. (It’s a
good idea to first move your previous version of MARPLOT to a backup
location.)  The rest of this section is for users updating from a version previous to
MARPLOT 3.0.

Note: The database-format (DBF) base maps that you used with a version of
MARPLOT previous to version 3.0 cannot be converted for use in MARPLOT 3.3.
You need to acquire new TIGER-derived maps for MARPLOT 3.3. See section
2.4.2 for more information.



Chapter 2: Installing and Managing Your MARPLOT System

12

2.4  Administration (system management)

2.4.1   Keeping backups

It is very important to keep backups of MARPLOT map information, especially
for maps that are edited by you or other users of your MARPLOT system.
Windows users can make these backups with the File Manager or Windows
Explorer, Macintosh users with the Finder. Following is a list of the types of files
you will want to back up:

Maps that are edited:

It is crucial that you make regular backups of those maps on which you
regularly add or modify objects. MARPLOT automatically saves all
changes to maps as they are made. Mistakes can easily mean lost or
corrupted data if you do not have backups.

To make a backup of a map, simply copy the map folder (directory) to a
backup disk, and change its name to include the backup date. If at some
time you need to restore from a backed-up copy, simply replace the map
folder (directory) with one from a backup disk (you will probably want to
make an extra backup of the map before restoring it).

Sometimes the map to be backed up will be in the MARPLOT folder
(directory), but remember that MARPLOT can use maps situated
anywhere on any of your disks. Thus, it is important for you to know
where all of your maps are in order to back them up. MARPLOT’s Map
List dialog box provides this information.

Usually, the maps you’ll want to back up are relatively small compared to
other maps, such as those derived from TIGER files. However, some users
will want to modify TIGER-derived county maps, and in some cases non-
TIGER maps can become quite large. If you are making only periodic edits
to these large maps, you should back them up in their entirety, as with
other maps. However, if the maps are very large, or if you are making
frequent edits, the backup procedure can be cumbersome and consume
too much disk space. In this case, you may only want to back up certain
layer files from a given map folder. As a simple example, suppose you are
making changes only to the “Water” layer of a certain TIGER-derived
map. Instead of backing up the entire map folder (directory) you can back
up only those files that start with “WATER.”  These files are WATER.LYR,
WATER.SUM, WATER.OBJ, WATER.SM2, and WATER.NNX (the latter
two files may not be present). You can copy these WATER files to your
backup disk. To restore from a backup, just copy the saved WATER files
back into the map folder (directory).
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Maps that are not edited:

Many users will not make changes to TIGER-derived county maps. And
there may be other maps on your system that are never modified. You
should keep at least one backup of these maps, just in case of disk error.

USERS folder (directory):

If your MARPLOT system is “multi-user,” there is a USERS folder
(directory) inside the MARPLOT folder (directory). The USERS folder
contains map files and other data such as saved views and search
collections created by each user. In most cases, the total size of this folder
will be fairly small, and you can back it up in its entirety. If a given user
needs to be restored from a backup, you can copy just that user’s folder
from the backup into the MARPLOT USERS folder.

Views and search collections:

The folders (directories) in the MARPLOT folder (directory) named
VIEWS and SEARCHES contain saved views and search collections. These
folders are usually relatively small, and can be backed up by copying the
entire folders to a backup disk.

Note: In a multi-user MARPLOT system, the VIEWS and SEARCHES
folders in the MARPLOT folder contain views and search collections
shared by all users of the system. Personal views and search collections for
each user are kept in that user’s folder within the USERS folder. These are
backed up along with the rest of the USERS folder.

MARPLOT settings files:

The files SETTING2.PLT, USER.PLT, LAYERS.PLT, GROUPS.PLT, and
XTRAMAPS.PLT, which are kept in the MARPLOT folder (directory)
should be backed up occasionally. They are all small.

Note: In a multi-user MARPLOT system, each user has his or her own
copy of SETTING2.PLT, USER.PLT, LAYERS.PLT, and GROUPS.PLT.
These are backed up along with the rest of the USERS folder.

MARPLOT application file:

You should keep your MARPLOT installation disks in case the application
file itself becomes lost or damaged on your hard disk.
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2.4.2   Adding maps to your MARPLOT system

See section 5.1 for step-by-step examples of adding maps.

Adding maps from the Web:

A map is a folder (directory) containing a number of layer files.  To obtain
map files, go to     http://www.epa.gov/ceppo/cameo/marmaps   /. Find the
desired state and county and download the maps. Often, you will copy
the new map folder (directory) into your MARPLOT folder (directory), in
which case the map is automatically recognized the next time you run
MARPLOT. If you want to copy the map to some other location, you will
need to use the Find New Map button (see sections 5.1 and 4.5.5) in
MARPLOT’s Map List dialog box in order to point out the new map to
MARPLOT (see the note below on infrequently used maps).

Adding maps from LandView CDs:

MARPLOT and LandView (a database application discussed in section
1.2.11) use the same map file format. For more information about
LandView , go to     http://landview.census.gov    .

Maps for all United States counties and territories are available on the
LandView DVD. If your computer does not have DVD reading capability,
you can order a custom CD-ROM for a single state or group of states. You
can use these files with MARPLOT. For ordering information, please go to
http://landview.census.gov/geo/landview/ordering.html   

If a LandView DVD or CD is in your computer then MARPLOT
automatically adds all of the maps on the DVD or CD to your Map List.
This allows you to work with any map on the DVD or CD as you do with
any other map, except you cannot make changes and map operations are
significantly slower for DVD/CD maps than for maps on a hard disk.

To speed up mapping operations, you may want to copy individual maps
from the CD/DVD to your hard disk. The maps are located in the Tiger
folder inside the “maps” directory. They are organized in county folders
within state folders. The county folders are identified by a five digit FIPS
number (for example, Los Angeles County , CA is 06037). The easiest way
to identify the FIPS number for the counties you want to copy to your
hard drive is to select Map List from the List menu in MARPLOT while
the CD or DVD is in the drive. In the Map List dialogue box, all the maps
are listed by name and folder. The last item under the folder column is the
five digit FIPS code. Copy the entire map folder to your hard drive from
the CD/DVD.
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Note: Infrequently used maps

Some users may have one or more maps that they plan to use only infrequently.
For example, a county might have a mutual aid agreement with other counties. It
would be nice to have maps for these other counties available, but since you use
them only rarely, it would also be nice if they didn’t appear in MARPLOT until
they were needed. For maps that you plan to use infrequently, there is an
advantage to keeping them somewhere other than the folder (directory)
containing the MARPLOT application: when maps are not in the MARPLOT
directory, you can use the Remove button in the Map List to remove them from
the list of maps. When they are removed, MARPLOT will not draw these maps,
or refer to them in places such as the Search Criteria dialog box. When you want
to use a map again after it has been removed, you can use Find New Map in the
Map List dialog box.

Thus, we have a procedure for turning infrequently used maps off and on: keep
these maps in a directory other than the directory containing the MARPLOT
application. Turn them off by removing them from the Map List. Turn them back
on by re-finding them in the Map List.

As to the question of where to keep these maps, if you are trying to conserve
space on the disk drive on which MARPLOT is located, you might want to put
them on an external disk drive, or on a removable disk. However, if you are
going to keep them on the same drive as MARPLOT, you should put them in the
XTRAMAPS folder (directory) within the MARPLOT directory (folder). This is
what the XTRAMAPS directory is for. (Note that there is also a file in the
MARPLOT directory called XTRAMAPS.PLT. This is related to, but different
from, the XTRAMAPS directory. You should not try to copy or edit this file. It
contains references to all maps in use by MARPLOT that are not in the
MARPLOT directory, including the maps in the XTRAMAPS directory.)

2.4.3   Exchanging data with other MARPLOT systems

There are two basic methods of exchanging map data: copying maps and map
files, or using MARPLOT’s import/export functions.

The simpler method is to copy entire map folders (directories) or individual map
files from one system to another. In cooperation with the people with whom you
are sharing map information, you may be able to set up your MARPLOT system
in order to use this simple copy method. For example, suppose a state with
twenty counties wants to keep a state-wide map of chemical facilities. Individual
MARPLOT installations in each county are responsible for mapping the facilities
for their county, and sending the data to the state. This state might design a
system where a different map is used to keep the facilities for each county. Each
county would plot its facilities and then send to the state the three map files
containing the data: FACILITY.OBJ, FACILITY.SUM, and FACILITY.LYR. When
the state receives these three files from a county, it copies them into that county’s
map folder (directory). From the point of view of the state’s MARPLOT system,
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there is still just a single FACILITY layer; it’s just distributed among several
maps.

In some cases, it may not be possible to transfer data simply by copying files. For
example, consider the situation where the state enters data for the facilities in all
counties onto a single FACILITY layer of a single map. The state sends this entire
map folder (directory) to each county. The counties are supposed to correct any
errors in the facilities in their area, and send only the corrected objects back to the
state. In this case, each county cannot send back the entire map, since the state
would have no way to combine the local parts from each county. Instead, each
county would select those objects it had modified and use Export from
MARPLOT’s File menu to export the objects into a text file using the MIE format.
Each county would send this text file to the state. The state would import each of
these text files as it received them. During the import, each updated object sent
from a county would replace the old object on the state’s map (MARPLOT knows
the objects correspond because their MARPLOT ID numbers are the same). In
general, this method of updating is slower and more error-prone than simply
copying maps or map files, when that option is available.

A step-by-step demonstration of both of these methods is given in section 5.7.

2.4.4   Administrating a multi-user MARPLOT system

If several people will be accessing the same map files with MARPLOT (either
because they all use the same computer at different times, or because you are
sharing map files among different computers with a network file server), you
may want to set up a multi-user system. The advantages of going to a multi-user
system are: (a) you can restrict certain users from making potentially destructive
map edits, (b) you can assign codes to each user to help track who adds and
modifies map objects, and (c) you can give each user separate program
preferences and a separate space for storing personal views, search collections,
and map objects.

MARPLOT is installed in single-user mode by default. To change to multi-user
mode, the person who is going to be the administrator of the system should
choose the Administrator item from MARPLOT’s File menu. After a warning,
you are asked to enter the administrator password, which initially is set to be
nimda. After entering this password and clicking OK, the system is converted to
a multi-user system and you are presented with the MARPLOT Administrator
dialog box.

The MARPLOT Administrator dialog box allows the administrator to add users
to the system and set their passwords, permission level (edit or browse), and
user codes (four-character codes that are attached to map objects when users add
or modify them). The administrator can also modify his or her own password,
and should do so as soon as possible. You can read more about the MARPLOT
Administrator dialog box in its on-line help topic.
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When your MARPLOT system is in multi-user mode, users must log in to
MARPLOT with a password each time they start it (an exception is the “guest”
user, which is automatically added to the system, and which has browse level
permission and no password). Only the administrator has access to the
Administrator menu item, which brings up the MARPLOT Administrator dialog
box again.

In multi-user mode, users with browse-level permission can only modify objects
on their personal user map, which, along with their preferences, is stored in their
user folder (directory) within the USERS folder (directory). Other users,
including the administrator, also have a personal user’s map, but they can add
and modify objects on other maps as well, including TIGER-derived county
maps. All users must unlock layers before performing any edits.

The administrator automatically has all the other users’ maps added to his or her
map list. Among other things, this allows the administrator to check objects that
browse-level users have created on their maps before moving them to a shared
map.

Any maps that the administrator adds to the system using the Find New Map
button in the Map List dialog box are automatically added to the map lists of all
users of the system.

Any views that are stored in the VIEWS folder (directory) within the MARPLOT
folder (directory) are available for use by all users of the system. Users with edit-
level permission can choose to save views into this directory to be shared with
other users. Any views saved by the administrator are automatically saved into
this directory and are therefore shared.

Once your system has been put into multi-user mode, it can be put back into
single user mode with the Stop Administration button in the MARPLOT
Administrator dialog box.

2.4.5   Using MARPLOT maps on a network

Since MARPLOT maps can consume a good deal of disk space, installations with
several computers connected via a local area network may want to share maps
using a network file server. In this way, it is possible for two or more users to be
working with the same map at the same time; that is, all users are drawing from
the same map files, which are stored on the network file server. This situation
presents no problems, so long as no user is attempting to make changes to the
shared map files while other users are viewing the shared maps. When a user
does make such changes, two problems are possible.

First, either the user performing the edits or other users of the shared maps may
be temporarily unable to access the map files. The editing user may get an error
alert saying that the map files could not be accessed to perform the given edits.
Other users may get an error alert saying that the map files are temporarily
unavailable for reading/drawing because they are being edited.
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Second, even if the editing user is able to make the changes without running into
error alerts, the other users of the map may not see the new edits immediately. If
it is important for those users to stay “up to date” with the edits as they are
made, they can simply quit MARPLOT and restart it. This will cause all new
edits to be shown when maps are drawn.

If possible, it is best to wait until you are the only one person using MARPLOT
before making edits to shared maps.

2.4.6   Creating new maps

Most MARPLOT users will never need to create a new map. Generally, you will
have one or more “base maps,” such as the U.S. county maps derived from
TIGER data. Then you may have one or more maps, each of which is associated
with a database program that shares information with MARPLOT. In all of these
cases, the map folders (directories) are provided for you; you do not need to
create them. If you need to add data to these maps (most commonly, you will be
adding to the maps associated with database programs), you can add to the
existing layers, or create your own layers on the existing maps.

Some users, however, may want to create new maps. If you are creating a map
based on a large amount of geographical information from some other data
source, you will want to automate the map creation process using MARPLOT
Import/Export (MIE) files (see section 2.4.8). There may be cases, however, when
you want to create a new “blank” map, and manually add objects to it in
MARPLOT.

Because creating maps in this way is not common, MARPLOT does not provide a
special function for it, such as a “New” button in the Map List dialog box.
However, there is a trick you can use to create new “blank” maps.

When you insert a picture object (see section 5.5), you are given the option of
using the picture as the first object on a new map. The idea is that the picture
might represent a new “base map” upon which you want to place other objects.
The trick for making a “blank” map is to create any picture in a painting or
drawing program, insert the picture, choose the option to create a new map, and
then delete the picture object from that map, leaving yourself with a new map
with no objects on it. You can then rename the map as you like using the Map
List dialog box.

2.4.7   Creating custom MARPLOT maps from other data sources

MARPLOT maps are created in a two-step procedure. First, the source data
(which may come from TIGER/Line files, data files from previous MARPLOT
versions, database files, or any source that includes latitude/longitude
information) is translated into a text file in the MARPLOT Import/Export (MIE)
format. Then this text file is converted into some number of MARPLOT 3.3
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binary map files (files ending with .LYR, .SUM and .OBJ) using the Import item
in MARPLOT’s File menu.

The two steps of this procedure can be carried out by hand, or can be automated
using MARPLOT’s IAC messages.

If you want to write your own translator, you will need the MARPLOT Technical
Documentation, which describes the MIE format in detail. The complexity of the
programming involved in creating such a translator varies depending on the
complexity of the source data.
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3   Getting Started with MARPLOT

This section provides a hands-on guide to the most common MARPLOT
functions. It uses the sample Prince William County, VA map that was
distributed with your MARPLOT system. This guide is meant to be used
interactively while you work at the computer with MARPLOT. You will get the
most out of it if you perform each step on your MARPLOT system, and try all of
the suggested tasks.

Further examples of various MARPLOT functions are given in Chapter 5.

3.1  Starting and exiting MARPLOT

On Windows...

To start MARPLOT, double-click its icon in the Program Manager or select
MARPLOT from the taskbar Start menu. Click OK on the greeting screen.
To exit MARPLOT, choose Exit from the File menu in the upper-left
corner of the MARPLOT map window.

On Macintosh...

To start MARPLOT, double-click its icon in the Finder. Click on the
greeting screen. To exit MARPLOT, choose Quit from the File menu.

3.2  Guided tour of basic MARPLOT functions

IMPORTANT NOTE:

For CAMEO users...

This guided tour makes use of objects on the CAMEO Map. The CAMEO
Map is a folder (directory) stored in the same place as your CAMEO
database or stack files. You must run MARPLOT and CAMEO
simultaneously on your computer at least one time before going through
this tour. To do this, start both programs and enter any necessary
passwords. Make sure you see the CAMEO Map objects in MARPLOT.
Then quit both programs. After having done this, the CAMEO Map
objects will continue to appear in MARPLOT, even when CAMEO is not
running.

For non-CAMEO users...

This guided tour makes use of objects on a map called CAMEO Map. Even
if you do not have this map, you should be able to follow along with most
steps of the tour. If you do have it, but you are not a CAMEO user, you
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should put it into your MARPLOT folder (directory) before going through
the tour.

Showing Different Layers

1. Start MARPLOT.

2. After you click on the title screen, MARPLOT opens the map window. The
sample map, Prince William County, is shown. (If, for some reason, your
MARPLOT does not open to this view, use the Go to View item in the View
menu, highlight the <entire map> view for Prince William County, and click Go
to View.)

Note: Your map window may not look exactly the same as the one shown in the
picture above. The scale value shown at the top of the window will probably be
different.

3. A number of different layers are shown, including the Places layer showing
the various towns in Prince William County, the water layer, and several
CAMEO objects, which are all clustered in the northern part of the county. With
the arrow tool, click several times on the map. As you select objects, they become
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highlighted with red dots, and MARPLOT displays their name at the bottom of
the map window. Also, the location of your click is marked with a flashing icon
called the Focus Point. The latitude/longitude coordinates of the Focus Point are
shown in the upper-left corner of the map window.

          

4. From the View menu, select the Redraw item. Watch the bottom of the map
window as MARPLOT draws. It shows which layer is being drawn. Use the
Redraw item a couple more times to get a feel for how long it takes MARPLOT to
draw the different layers on your computer.

5. Use Redraw one more time, but this time, try to press the ESC (escape) key as
soon as MARPLOT starts drawing the Water layer. Pressing the ESC key causes
MARPLOT to stop drawing. It displays the message [DRAW INCOMPLETE] at
the bottom of the map window to remind you that all of the layers to be drawn
were not drawn. Even when the drawing is incomplete, however, you can still
click on the map with the arrow tool to select any object that would have been
drawn. With the map partially drawn, try clicking on some of the CAMEO
objects in the northern area of the county.

          

6. Use Redraw one more time to display all of the shown layers.

7. From the list menu, select the Layer List item. This brings up MARPLOT’s list
of layers. The layers can be sorted alphabetically or from top to bottom according
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to the order in which they are drawn. Currently the layers are sorted in draw
order. Scroll up and down in the list of layers. Notice that the TIGER-derived
layers such as Places and Roads are lower in the list than the CAMEO layers such
as Facilities and Hospitals. Since the layers are shown according to the draw
order, this means that the TIGER-derived objects will draw first, on the
“bottom,” and then the CAMEO objects draw after, on the “top.”  That’s why,
when we stopped the drawing, we saw some of the TIGER layers (the shoreline,
the places, and some of the water) but the CAMEO objects still hadn’t been
drawn.

8. In the Layer List, click on the names of different layers. Notice that, in the
bottom part of the window, MARPLOT displays the number of objects on that
layer, and also some graphical information about the layer.
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9. As can been seen in the columns in the center of the Layer List, all of the
CAMEO layers are currently in “Show” mode, and most of the TIGER-derived
layers (roads, railroads, etc.) are currently in “Range” mode. When a layer is in
Show mode, it displays no matter what the map scale. When a layer is in Hide
mode, it does not display. When a layer is in Range mode, it displays only within
a certain range of map scales. For now, let’s put all of the non-CAMEO layers
except for the Places layer into Hide mode. To do this, click on each layer’s line in
the Hide column.

10. Click OK. The map is redrawn with just the Places and CAMEO layers
shown.
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11. Return to the Layer List dialog box using the Layer List menu item again.
This time, set the Roads layer to Show mode by clicking in the Show column of
the Roads layer’s line.

12. Click OK. The map is redrawn with the Roads layer shown.

13. It takes a significant amount of time to draw all of the roads at this zoomed-
out view of the entire county. It would be better to draw the roads only when we
are zoomed in closer. That way, we wouldn’t have so much to draw at one time.
This is just what the Range setting in the Layer List dialog box is for. Return to
the Layer List and set the Roads layer to Range mode. In order to see what range
of scales the roads will show in, make sure the Roads layer is highlighted in the
list and then click on the Scale Ranges button.
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14. The Layer Scale Ranges dialog box displays and lets you modify four scale
values: the most zoomed-out scale the layer will display at, the most zoomed in
scale the layer will display at, the scale you have to zoom in to before objects on
the layer are labeled with their names on the map, and the scale you have to
zoom out to before symbol objects on the layer are displayed as dots instead of as
their usual icons.

15. Note that, in the case of the Roads, the layer is set to show when the scale is
about 1 inch = 2 miles. Note that our current scale is more zoomed out than that.
Thus, if we leave these scale values, and leave the Roads layer in Range mode,
we’ll have to zoom in a bit close for the roads to appear.

16. Click OK to exit the Layer Scale Ranges dialog box, and then click OK to exit
the Layer List dialog box. Notice that the roads are no longer displayed. Let’s
zoom in closer using the magnifying glass tool, . Click on this tool and then,
with the magnifying glass, click about in the center of the county. This causes the
view to zoom in by a factor of 2, centered on the point of your click. Note that the
number of miles per inch has been cut in half. (Note: You may find that after
zooming the Places layer containing the county and cities is hidden.)

          

17. The roads still do not display because, as we saw in the Layer Scale Ranges
dialog box, they are set to show only when we are zoomed in to at least 1 inch =
2 miles. Click one more time with the magnifying glass, again around the center
of the map window. Now the roads appear because we have zoomed in past the
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threshold scale. If we continue to zoom in with the magnifying glass tool, we can
reach the scale at which the names of the roads appear. (Note: Depending on the
settings in your copy of MARPLOT, you may have to zoom in a bit father to see
the road names.)
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18. You may also have noticed that, as we were zooming in, the cities and towns
disappeared. That is because the Places layer, like the Roads layer, is currently in
Range mode, and the Places are set to turn off when we zoom in past a certain
scale. To see this, return to the Layer List dialog box, highlight the Places layer
and click on the Scale Ranges button.

19. Since it’s true for most layers that you’ll only want to see them within a
certain range of scales, it is common for most of the layers to be set to Range
mode. There are some exceptions. For instance, there may be relatively few
objects on certain layers, such as the CAMEO layers. Since these layers draw very
quickly, you might want to leave them always in Show mode. On the other hand,
consider the Census Block Groups layer. This layer contains a large number of
polygons that take a while to draw. It’s not that you want them to show only
when you are zoomed in close. Rather, you will probably want to keep them in
Hide mode until you need them, set them to Show mode while you work with
them, and then set them back to Hide mode.

20. For now, let’s set all of the TIGER-derived layers except for the Census Block
Groups layer back to Range mode. As you do so, you may want to click on the
Scale Ranges button to see the range setting for some of the other layers. Then
use the Go to View dialog box to return to the <entire map> view for Prince
William County.
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Navigation and Views

21. In the preceding steps, we’ve already seen two ways to navigate around the
map: the Go to View dialog box, and the plus magnifying glass tool. You may
have guessed that the minus magnifying glass tool  is used to zoom out, also
by a factor of 2. Two other tools along the left edge of the map window are also
used for changing the view. The hand tool  is used to shift the map view
without changing the scale. The plus magnifying glass tool  can also be used to
zoom into a particular rectangular area. Select the plus magnifying glass tool
now by clicking on it. With the entire Prince William County map in view, notice
the two hospitals objects (red crosses) among the CAMEO objects. Let’s zoom
into an area just big enough to show both hospitals. Click with the magnifying
glass above and to the left of the top hospital. With the mouse button still down,
drag below and to the right of the bottom hospital. A gray box defines the region
as you drag. When you have just surrounded both hospitals, release the mouse
button. MARPLOT changes the view to show the area defined by the rectangle.

Note: If you make a mistake using the magnifying tool, you can always return to
the last view using the Go to Previous View item in the View menu. Also, if you
start defining the rectangle and then decide you don’t want to zoom after all, you
can press the ESC key while the mouse is still down to abort the zoom.
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22. The new map window now displays the selected area. We can save this view
for future reference. Select the Save Current View item from the View menu.
Name the view “Two Hospitals” and click OK.

  

23. To show how the view is used, use the hand tool to shift the map view. To do
this, click with the hand tool near the top of the view, drag down to the bottom of
the window and then release the mouse button. This shifts the view to the north.
Now select the Go to View item in the View menu, highlight the Two Hospitals
view, and click Go to View. You are returned to the saved view.
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24. Use the Go to View dialog box again to return to the <entire map> view of
Prince William County. Let’s save this view also, using Save Current View. Let’s
name it PWC Image.

  

25. Another use for saved views is as a reference view. To see how reference
views work, return to the Two Hospitals view again using Go to View. Then
click on the triangle in the upper-right corner of the map window, go to the
Reference View submenu, and choose Set. Select the PWC Image view, leave the
“allow any view in reference” box unchecked, and click Set Reference View.
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26. The reference view, showing the PWC Image, appears in the upper-right
corner of the map window. The reference view shows the location of the current
view in the map window relative to some other view. In this case, we see the area
of the Two Hospitals view relative to the entire area of Prince William County.
The flashing red box indicates the shown area.

          

27. Use hand and magnifying glass tools to move all around the map. Notice
how the flashing rectangle in the reference view follows you. Zoom in as far as
you can go. Notice that, when the flashing rectangle gets too small, it is replaced
by a cross-hairs, pinpointing your location. You can double-click at a point on the
reference view to view that area. Try double-clicking a few times on the reference
view. Also, by clicking once and dragging on the reference view rectangle, you
can reposition it in the map window.

28. Let’s try one more experiment with the reference view. Return to the Two
Hospitals view using Go to View. Click once with the plus magnifying glass in
the center of the map window. Now set the reference view again, this time
choose the Two Hospitals view as the reference view (again, leave the “allow any
view in reference” box unchecked). As we saw before when using PWC Image as
the reference view, here the Two Hospitals is serving as a reference view and the
flashing rectangle shows the area of the current map window relative to it.

          

29. This time, however, notice what happens when you use the minus
magnifying glass to zoom out two times. As soon as the view in the map window
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no longer fits within the Two Hospitals reference, MARPLOT automatically
changes the reference view to the PWC Image. If you then zoom back into an
area within the Two Hospitals view, MARPLOT automatically changes the
reference view back to the Two Hospitals view. These automatic changes happen
because we had the “allow any view in reference” box unchecked when we set
the reference view. When this box is checked, MARPLOT allows a view to stay in
the reference view, even when the current map view does not fall completely
inside of it.

          

30. When you have saved a view and are sure you no longer want to work with
it, you can delete it using the Edit Views item in the View menu. Select Edit
Views now and delete both the Two Hospitals view and the PWC Image view.
Click OK. Notice that the reference view is closed automatically because we
deleted the view it was using.
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Searching for Cities and Roads

31. One of the most common operations you will perform in MARPLOT is
searching for an object, often for an address range or intersection of a certain
road. Another common search, if you are working in a large county, is to find a
certain city or town within the county. Let’s search for a town within Prince
William County. Bring up the Search Criteria dialog box by selecting Search from
the List menu.

32. Click on the pop-up box after the label “Search for objects that:” and select
“have any name.”  After “Layer(s) to search:” choose “Individual Layer...” in the
first pop-up box and “Places” in the second pop-up box. After “Map(s) to
search:” choose “Maps in View” and leave the final pop-up box set to “replace
previous collection.”  Then click the Search button.

33. MARPLOT performs the search, and puts all of the objects that match the
specified criteria into the Search Collection. In this case, we found all of the
objects on the Places layer of the Prince William County map. The Places layer
contains one polygon object representing each city or town in the county, plus a
single polygon object representing the boundary of the entire county.
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34. Find “Dumfries town” in the list and click on its name to highlight it. Click
the Show on Map & Zoom button. This causes MARPLOT to change the view so
that Dumfries town just fits into the map window.

35. You may recall from earlier in this guided tour that the Places layer was set to
Range mode, and normally the Places would not be visible at this new scale
where Dumfries town fills the map window. However, since we asked
MARPLOT to show Dumfries town on the map, it automatically changed the
Places layer to Show mode. Let’s go back to the Layer List and set the Places
layer back to Range mode.
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36. Now we see the same area without the Places polygons cluttering the view.
There is a street in Dumfries town named “Fairfax St.”  Let’s use the Search
function to find this street. In the Search Criteria dialog box, search for objects
that “have names that start with.”  Type the letters “fair” in the box that appears
in the upper-right. Search on the “Individual Layer” named “Roads.”  Again,
search on “Maps in View” and choose “replace previous collection.”  Click
Search.

37. Again, the Search Collection dialog box comes up with the results of the
search. Highlight “Fairfax St” and click Show on Map (we do not use Show on
Map & Zoom this time because we don’t want to change the viewing scale; if we
had used Show on Map & Zoom, MARPLOT would have changed the view to
show just the area covered by Fairfax St in the map window).
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38. MARPLOT highlights Fairfax St on the map with red dots and shows its
name at the bottom of the map window. It also puts the Focus Point at the center
of the street.

39. Use the plus magnifying glass tool to zoom into an area that shows just
Fairfax St, plus a little extra space for borders.

          

40. Suppose we want to know where the address 250 Fairfax can be found. Go
back to the Search Collection using the Show Search Collection item in the List
menu. With “Fairfax St” highlighted, click on the Addresses button.

41. MARPLOT displays the list of address ranges for Fairfax St. In this case, we
see that there is an error in the TIGER data: the bogus address range 0-109. The
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example in section 5.1 shows how you can correct this type of data error. For
now, we are looking for address 250, which falls within the range 210-299.
Highlight this range in the list and click Show on Map.

42. MARPLOT shows the location of the address range by positioning the Focus
Point at the center of the segment that corresponds to the selected range.

43. Now suppose we want to find the intersection of Fairfax St and Duke St.
Again, bring up the Search Collection using the Show Search Collection item in
the List menu. With Fairfax St highlighted, click on the Intersections button.
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44. MARPLOT lists all of the streets with which Fairfax St intersects. Highlight
Duke St in the list and click Show on Map (Show on Map & Zoom would change
the scale to an appropriate scale for viewing the intersection, but in this case we
are already at such a scale).

45. MARPLOT selects both Fairfax St and Duke St, and puts the Focus Point at
their intersection.

46. This concludes the MARPLOT guided tour. If other people will be taking this
tour using this MARPLOT system, please use the Go to View dialog box now to
return to the <entire map> view for Prince William County. Then exit from
MARPLOT. You can find more step-by-step examples of using MARPLOT in
Chapter 5.
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4   Reference

4.1  The MARPLOT display window

The MARPLOT window contains many components.

The title of the window displays the name of the map currently shown in the
window, or simply “MARPLOT” if more than one map is shown.

Just below the title is a line containing three pieces of information:

First, the latitude/longitude coordinates of the Focus Point are given. The Focus
Point is the flashing target-shaped icon that marks the location of the most recent
point of interest. You can change the format of the latitude/longitude values
using the Preferences item in the File menu.

Second, the current map scale is given, in one of three different formats, as
chosen using the Preferences item in the File menu.

Third, the name of the reference view is given, if a reference view is currently
being shown (see the View menu).

The various tools are along the left side of the map window. The currently
selected tool is shown highlighted. The function of each tool is described in
section 4.8. When you have unlocked one or more layers (see section 4.5.4),
additional tools, used for creating new objects, appear.

Along the bottom of the map window is a status line that is used to display
various messages. Among other things, it gives the name, layer, map, and
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Census classification of the most recently selected object. If you pressed ESC to
cancel a time-consuming map draw (see section 4.4.13) this bottom line will
display the words “[DRAW INCOMPLETE]” to remind you that you are looking
at an incomplete picture.

When you select objects on the map (usually by clicking them with the arrow
tool) MARPLOT indicates that they are selected by drawing small red squares
along their borders.

Finally, if you are using the Marked Point (see section 4.4.13), it appears as a
pink, target-shaped icon.

Remember that what you see in the map window depends upon (a) the area you
are looking at, (b) the current scale (remember that layers can be set to show only
at certain scales), (c) the order of the layers (layers can draw over one another),
and (d) the maps that are currently in use. If you are not seeing what you expect,
consider each of these factors.

4.1.1  Pop-up menus on the map window

The status lines at the top and bottom of the map window show small black
triangles indicating that you can click in the given area to activate a menu that
lets you perform functions related to the item displayed. For instance, clicking in
the “Focus Pt” area brings up a menu of functions related to the focus point,
while clicking on the map scale area brings up a menu of functions related to
map scale. The function of each of these pop-up menu items is explained below.

Clicking in the “Focus Pt” area at the top of the map window brings up the
following menu:

• Copy Coordinates copies the displayed Focus Pt coordinates to the clipboard.
• Coordinate Format... brings up the Preferences dialog box so that you can
change the format in which coordinates are displayed.
• The remaining items in this menu perform the same function as the identically
named items in MARPLOT’s regular View, Marked Point and Vertex menus.

Clicking in the map scale area at the top of the map window brings up the
following menu:
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• Copy Scale copies the displayed map scale to the clipboard.
• Scale Format... brings up the Preferences dialog box so that you can change the
format in which map scales are displayed.
• Zoom In and Zoom Out change the map scale by a factor of two, centered at
the focus point (note that Zoom In and Zoom Out are not included in the View
menu).
• Set Scale... performs the same function as the identically named item in the
View menu.

Clicking in the reference view name area at the top of the map window (the
rectangle just to the right of the map scale area) brings up the following menu:

• Copy Name copies the displayed reference view name to the clipboard (if a
reference view is currently shown).
• Reference View allows you to show or hide the reference view, and choose the
view to be used as a reference view.
• Legend allows you to show or hide the legend, and set legend options.
• Scale Bar allows you to show or hide the scale bar, and set scale bar options.
• Time Stamp allows you to show or hide the time stamp, and choose time stamp
options.

Clicking in the message area at the bottom of the map window brings up the
following menu:

• Object Settings... and Segment Settings... perform the same function as the
identically named items in the Objects menu.
• Copy Object Record copies to the clipboard the MIE (MARPLOT
Import/Export) record for the selected object.
• Copy Object Coordinates copies to the clipboard the list of latitude/longitude
coordinates for the selected object.
• Copy Text copies whatever text is in the message area to the clipboard.
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4.1.2  Map insets

The reference view is just one of four insets that you can display in the map
window. Each of the four insets is discussed in this section.

You can show and hide the various insets, and set a number of options related to
their display using the Preferences dialog box (see the File menu) and the pop-
up menu in the reference view name area of the map window. To position any of
the insets, click on them with the mouse and drag to the desired location.
MARPLOT remembers this as the position of the inset until you move it again.

When you print or save the contents on the map window, any displayed insets
are included in the output.

Reference view

Double-click anywhere on the reference view to center the map view about the
clicked location.

Legend

The legend displays a map key in one of two formats. You can either display one
line for each of the shown layers (with an option to exclude specific shown layers
from the legend), or you can display an arbitrary picture/bitmap, which is
usually a legend image that has been prepared using another program.

Double-click the legend to bring up the Preferences dialog box where you can set
options for the display of the legend.

Scale bar

The scale bar inset shows the current map scale in a number of available formats
including a number line marked with English units, a number line marked with
metric units, a equation with “1 in = ...”, and an equation with “1 cm = ...”.

Double-click the scale bar to bring up the Preferences dialog box where you can
set options for the display of the scale bar.
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Time stamp

The time stamp displays the current date and time in any of a number of
available formats. You can also include an arbitrary one-line comment in the time
stamp.

Double-click the time stamp to bring up the Preferences dialog box where you
can choose date and time formats, and enter the one-line comment.

4.2  File menu

The items in the File menu allow you to perform a variety of input/output
functions, and to accomplish miscellaneous system-level tasks.

Note that there is no “Save” item in the File menu. When you make changes to
objects on maps, the changes are immediately written to disk. This means that
there is no need for you to explicitly save any changes you make. The price of
this convenience, however, is that you need to be that much more careful to keep
backup copies of any maps you will be editing, so that you can revert to a saved
version if you make invalid changes (see Chapter 2).

4.2.1   Save as Picture

The Save as Picture menu item is used to save an image of what is currently
drawn in the map window to a picture file. Such a file can be opened with a
standard draw/paint program. The procedure for saving a picture differs
slightly between Windows and Macintosh.

Save as Picture on Windows...

When you choose Save as Picture, you are presented with a standard file-
saving dialog box to specify the file to be saved. You can choose to save a
bitmap file (type “.bmp”) or a metafile (type “.wmf”). Metafiles are often
smaller than bitmap files, and have the advantage that certain programs
will allow you to edit them on an object-by-object basis. However, bitmap
files are more common and can be opened with standard programs such
as PaintBrush.

A check box, which only applies when you are saving a metafile (type
“.wmf”), gives you the option of saving into the picture only the currently
selected objects. This is useful if you want to save into the picture a less
“cluttered” view of a certain set of objects.

Save as Picture on Macintosh...

When you choose Save as Picture, you are presented with a dialog box
that lets you specify the size of the picture to be saved. By default, the
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saved picture is the same size as the screen display. If you want to expand
or shrink the image when saving, you can specify the desired size either
by giving its dimensions (width and height), or by specifying the map
scale that you want the picture to have.

A check box gives you the option of saving into the picture only the
currently selected objects. This is useful if you want to save into the
picture a less “cluttered” view of a certain set of objects.

When you click OK to confirm the size, you are presented with a standard
file-saving dialog box to specify the file to be saved.

4.2.2   Print

The Print menu item is used to print what is currently drawn in the map window
to your printer. Before printing you may want to use the Print Setup (Page Setup
on Macintosh) menu item to alter general printing settings.

When you choose the Print item, you are presented with a dialog box that lets
you specify the size of the printed output. By default, the printed output is the
same size as the screen display. If you want to expand or shrink the image when
printing, you can specify the desired size either by giving its dimensions (width
and height), or by specifying the map scale that you want the output to have.

IMPORTANT NOTE: Do not attempt to change the size of the printed output by
using the Reduce/Enlarge or Scaling fields in the Print Setup/Page Setup dialog
box; leave it at 100%. If you want an output that is reduced or enlarged, you can
achieve this by modifying the width, height or scale fields in the Print dialog box.
For instance, to reduce the image by 50%, change the width (or height) field to
1/2 its original value.

The Print dialog box displays the size of a printed page as well as the number of
pages that will be printed, according to the dimensions or scale you have
specified.

A check box gives you the option of printing only the currently selected objects.
This is useful if you want to print a less “cluttered” view of a certain set of
objects.

4.2.3   Import

WARNING: Use this menu item with caution. Incorrect use can result in lost
data. It is safest to back up your map files before importing. The Import menu
item is only available to users who have edit-level permission.

NOTE: If your MARPLOT system uses map files shared over a network file
server, make sure that no other users are currently using the shared map files
before you use Import.
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The Import menu item is used to read in a list of objects from a text file. This file
can be in one of four different formats:

• the MARPLOT Import/Export (MIE) format

This is that standard format for exchanging MARPLOT
information. These files contain complete MARPLOT information
about each object.

• the MARPLOT Simple Point format

In this format, the objects appear one-per-line. Each object is
specified as a single point. Besides the coordinates, the following
attributes may be included: name, layer, map, symbol, color, ID.

• the ArcInfo™ GENERATE format

This format is provided to allow MARPLOT to exchange data with
ArcInfo. Besides the coordinates, the following attributes may be
included: name, layer, map, symbol, color, ID.

• the MARPLOT 1.0.1 (for Macintosh) export format

This format is used only to bring objects from MARPLOT 1.0.1 into
MARPLOT 3.3.

For more information about any of these formats, see the MARPLOT Technical
Documentation.

When you import a file, the objects specified in the file are added to your map(s).
If the objects in the file are from maps that are not currently available on your
MARPLOT system, new maps will be created to accommodate the objects.
Similarly, if the objects are from layers that are not in the current system, new
layers will be created. Any maps created during import are put in the same
folder (directory) as the MARPLOT application itself.

As explained in section 1.2.8, when you import an object with a given ID
number, layer name, and map name, MARPLOT will use this object to replace an
existing object with the same ID, layer name and map name. This occurs even if
the layer in question is currently locked. However, you have the option of
modifying this default behavior using the Options button in the Import dialog
box. In the event of ID conflicts, you have the alternatives of skipping the
conflicting object, or adding the conflicting object without deleting the original
(resulting in duplicate ID numbers on the same map/layer).

The most common use of Import is to share data with another MARPLOT
system. A user of that system can export certain objects to an MIE file. You can
then import the MIE file in your system. Any new objects (i.e., objects that were
created in the other system but don’t yet exist in your system) will be added to
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your system. Any objects that match existing objects in your system (i.e., that
have the same ID number, layer name, and map name) will replace those existing
objects (unless you have used the Options button to change this behavior). The
net effect is that your system will be “updated” to match the objects in the other
system. Keep in mind, however, that if you import bad data, you may lose
important data that you have entered in your system.

4.2.4   Export

The Export menu item is used to write a list of objects to a text file. The objects to
be written can be either those objects currently selected on the map, or those
objects currently in the search collection. You can export in one of three formats:

• the MARPLOT Import/Export (MIE) format
• the MARPLOT Simple Point format
• the ArcInfo™ GENERATE format

In the case of the two latter formats, you can output the coordinates along with
any subset of the following attributes: name, layer, map, symbol, color, ID.

These formats are described above and in the MARPLOT Technical
Documentation.

4.2.5   Compact Map Files

NOTE: If your MARPLOT system uses map files shared over a network file
server, make sure that no other users are currently using the shared map files
before you use Compact Map Files.

The Compact Map Files menu item, which is mostly for use by MARPLOT
system administrators, performs a number of optimizations on your maps to
make them draw more quickly and use less disk space. You will only need to use
Compact Map Files after importing or after making a large number of changes to
your maps. There is no harm in using Compact Map Files at other times, but you
should not expect any improvement in efficiency.

Compacting your map files can take less than a minute if your maps are small
and/or are already mostly compacted. However, for large, uncompacted map
files, the process can take up to an hour or more (you can stop the process at any
point if it is taking too long).

Before choosing the Compact Map Files function, you should make sure you
have sufficient free disk space. A rule of thumb is to make sure you have free on
each disk containing a map folder at least twice the space of the single largest
“.OBJ” layer file on that disk. If MARPLOT is unable to complete the compaction
process because of low disk space, it will tell you.

Compact Map Files performs two main functions to improve map file efficiency.
First, it removes the space occupied by deleted objects from the map files.
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Second, it sorts the objects in each map file geographically, for improved speed
during drawing. Compact Map Files also does some other cleanup work on your
map files. If you think your map files have been corrupted somehow, you might
try compacting them to fix the problems.

When you use Compact Map Files, even those files belonging to locked layers are
checked and compacted. However, files belonging to maps that are not currently
in use will not be touched (use the Map List menu item to see which, if any, of
your maps are not in use).

4.2.6   Preferences

Because of the large number of preferences that you can set in MARPLOT 3.3, the
Preferences dialog box is broken up into five tabbed panels. Move between the
panels by clicking the tabs at the top of the window.

The Colors panel lets you set the background color for the map window.

The Tools panel lets you set preferences for various tools. (These choices are also
available by double-clicking the tool icons on the left edge of the map window.)
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The Latitude/Longitude panel lets you choose the format in which coordinates
are displayed, and control the lat/long grid in the map window. You can choose
whether latitude/longitude values are displayed as degrees with a six-place
decimal (e.g., 40.250000°), as degrees followed by minutes (e.g., 40°25.10’), or as a
triplet of degrees, minutes, and seconds (e.g., 40°25’00’’). Notice that you can
display the grid above or below the map, and you have the option of including
unlabeled intermediate lines, when a dense grid is desired.

The Scale panel lets you choose the format in which the scale is displayed at the
top of the map window, and in the scale bar inset. You can view the scale as a
ratio (such as “1:50000”), in terms of units (such as “1 in = 10 mi”), or in terms of
window dimensions (such as “5 x 3 mi”).
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The Legend panel lets you choose which type of legend to display, a picture or a
list of the shown layers. For a picture legend, you can choose any picture from a
bitmap or PICT file on your disk using the Set button. For a layers legend, you
can choose to exclude specific shown layers from the legend by double-clicking
them.

The Date/Time panel lets you choose formats in which the date and time are
displayed in the time stamp inset. The one-line comment you enter here is
included in the time stamp.

4.2.7   Administrator

See section 2.4 for more information about MARPLOT administration.

The first time this menu item is used, it puts MARPLOT into “multi-user” mode
(as opposed to “single-user” mode). In “multi-user” mode, one person (usually
the one who first uses the Administrator menu item) is the system administrator.
The administrator has the ability to add other users to the system, giving them
passwords and user codes.

After the first use of the Administrator menu item, the item is only available to
the MARPLOT system administrator. It brings up a dialog box in which the
administrator can add new users and modify user settings. For each user, the
administrator can set the user’s name, password, and permission level (edit or
browse). Each user is also assigned a four-character code that is attached to each
object the user creates and/or modifies. Using the Object Settings dialog box for
a given object, you can see the code of the creator and last modifier of the object.

Note that the administrator can change his or her own password. The
administrator should do this as soon as the Administrator menu item is chosen
for the first time.

Once MARPLOT is in multi-user mode, it is possible to return to single-user
mode. The administrator does this using the Stop Administration button in the
MARPLOT Administrator dialog box. This renames the USERS folder as
USERSX. If the Administrator menu item is chosen again, USERSX is renamed
USERS, and the previously established administration is reinstated.
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4.3   Edit menu

The Cut, Copy, and Paste items in the Edit menu are not used to cut, copy, and
paste MARPLOT objects. While you cannot use the Edit menu to perform these
functions, MARPLOT provides a number of mechanisms to accomplish the
desired goals. To move objects, select one or more and drag them with the arrow
tool. To change an object’s layer or map, use the Object Settings dialog box. To
change several objects at once, use the Move items in the Objects menu.

4.3.1   Undo

You can undo the last change you made to the objects on the map. For instance, if
you accidentally delete an object, you can use Undo to get it back. Similarly, if
you accidentally move an object, you can return it to its original position. Some
complex operations, such as importing a group of objects, cannot be undone.

4.3.2   Cut

Cut has no function in MARPLOT. It cannot be used to cut MARPLOT objects to
the clipboard.

4.3.3   Copy

Copy has no function in MARPLOT. It cannot be used to copy MARPLOT objects
to the clipboard.

4.3.4   Paste

Paste has no function in MARPLOT. It cannot be used to paste MARPLOT
objects from the clipboard.

4.3.5   Clear

Clear deletes the currently selected map objects. You can get the objects back
right after the clear using Undo.

4.3.6   Insert Picture Object

The Insert Picture Object menu item is used to create a new picture object.

What is a picture object?

A picture object is like a rectangle object that is filled with an image, instead of
with a standard pattern. Picture objects are like other objects in that they can be
named, moved, deleted, etc. You can have as many picture objects as you want,
on any layers.
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The most common use for a picture objects is as a “base map” onto which you
place other map objects. The idea is to place a picture object, which covers a
fairly large geographical area, onto a layer that is near or at the bottom of the
layer list. You can then place other objects, such as icons representing facilities,
on other layers that are on top of the picture object’s layer. While the picture
object is technically an object just like those that are placed on top of it, by
leaving the picture on a low layer, and by leaving that layer locked, you can
achieve the effect of having the picture represent the “background” or “base
map.”

However, picture objects may also be used as “small” objects in their own right.
For instance, you might have a logo or other design that you want to place
directly on your map. You can do so using a picture object.

Inserting the picture object

When you choose the Insert Picture Object menu item, MARPLOT asks if you
want the picture object you are about to add to be the first object on a new map
(i.e., the “base map” for the new map) or an object on an already-existing map. If
you choose to make a new map, the name of the map will be the same as the
name of the picture file you select.

The image for the picture object can come from either a picture file (i.e., a file,
usually made by a painting or drawing program, that contains a picture) or from
the clipboard (when you have just copied a picture to the clipboard using the
Copy menu item in some other program). If you have copied a picture from
another application before choosing the Insert Picture Object menu item,
MARPLOT asks if you would like to use that picture, or choose another from a
picture file. However, when you are creating a new map, the image must come
from a picture file, not the clipboard.

If you choose to insert a picture from a picture file, MARPLOT then lets you
locate the picture file on the disk.

MARPLOT reads the picture (either from the clipboard or the file) and creates a
new picture object. It then brings up the Object Settings dialog box for the new
picture object, to allow you to change any of its settings. As with other objects,
you should be careful to make sure the picture has been placed on the correct
layer and map.

Geo-referencing the picture object

Especially important at the time you create a picture object is the Geo-Reference
button in the Object Settings dialog box. The point of the Geo-Reference button is
to let you specify exactly where on the earth the new picture object belongs. In
some cases, such as when you are using picture objects as “designs” instead of as
“base maps,” you will probably not need to geo-reference your picture objects at
all; it will be sufficient to drag and stretch them, like other objects. But for large
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“base map” picture objects that are supposed to represent a precise area, you will
usually want to geo-reference them to indicate exactly where they go.

If you do not geo-reference the new picture object as it is being created, it will be
placed initially so that it is centered about the Focus Point and scaled to its
standard size. No harm is done, since you can always geo-reference the object at
a later time.

Note to Macintosh users: some picture files, such as those output by previous
versions of MARPLOT, already have lat/long information about the picture they
contain stored in a resource. When you insert one of these picture files,
MARPLOT will automatically use the provided lat/long values, and no geo-
referencing is necessary, unless you want to place the picture object in a different
location.

You can read more about geo-referencing in section 4.6.1.

Finishing up

From the Object Settings dialog box, click OK when you are happy with the
settings for the new picture object, or Cancel if you decide not to create the object
after all.

When you click OK, MARPLOT creates a file within the folder (directory) of the
picture object’s map to keep a copy of the picture.

4.3.7   Make New Polygon

This menu item performs different functions depending on which objects are
currently selected.

If a single polyline object is selected, it creates a new polygon object that forms an
“envelope” around the selected polyline. An envelope is a complex polygon
object that is constructed to cover the map area within a given distance from any
point on the polyline. You use the Make Envelope Polygon dialog box to specify
this distance. For instance, if the polyline represents a road, and you want to see
the area that is within 100 yards of any point on the road, you would specify 100
yards in the Make Envelope Polygon dialog box, and the resulting polygon
would cover the desired area. Once the envelope is created, you can use it, for
instance, to see what other objects fall within it.

If two or more polygon objects are selected, it creates a new polygon object that is
the intersection, union, or difference of the selected polygons, depending on your
choice in the Make New Polygon dialog box. The intersection is the area that all
of the selected polygons have in common. The union is the area that all of the
selected polygons cover in total. The difference is the area of the first-selected
polygon (the one you clicked first in the map window), excluding the area of the
other selected polygon(s). As a simple example, suppose you have several
polygons and want to calculate their total area. Instead of finding the area of each
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and adding up the total manually, you could select all of the polygons, use Make
New Polygon to create their union, and use the Object Settings dialog box to find
the area of the union object.

For the purposes of Make New Polygon, rectangle and circle objects are treated
like polygons.

The object created by Make New Polygon (the envelope, the union, the
intersection, or the difference) is placed on the Temporary Layer of your user’s
map. Objects on the Temporary Layer are deleted when you quit MARPLOT. If you
want to save them, move them to another layer before quitting.

There are some technical problems related to polygon unions and “buffer” zone
polygons (which are really just a type of polygon union). Descriptions of these
problems, and how they are solved by MARPLOT 3.0, 3.1 and MARPLOT 3.3,
can be found in the MARPLOT Technical Documentation.

Related to polygon unions is the issue of how MARPLOT computes polygon
areas. This topic is also covered in the Technical Documentation.

4.3.8   Make New Polyline

Make New Polyline is used after you have selected two or more polyline objects.
It creates a new polyline object on the Temporary Layer that contains all of the
segments of the selected polyline objects. It can be thought of as a “union”
operation for polylines. Note, however, that attributes of the component
polylines, such as street addresses, are not included in the combined polyline.

4.3.9  Polyline <-> Polygon

Polyline <-> Polygon converts the selected object from one type to the other. This
is useful, for instance, to “close off” and fill a polyline boundary.

4.4   View menu

The items in the View menu are used for navigating around the map, for saving
and using views, and for using the map insets and other map window displays.

A view is a rectangular window onto a certain area of the world. When you save
a view, MARPLOT records the rectangle, along with a miniature image of what
is shown in the map window at the time the view is saved. Depending on the set-
up of your MARPLOT system, there may be a number of views available for
your use beyond those that you have saved yourself. Also, if your MARPLOT
system is multi-user, you can choose whether the saved view is for your use
only, or is to be shared with other users.

Any saved view can be used as a “reference view.”  When a view is used as a
reference view, the miniature image of the view is placed in an inset on the map
window. MARPLOT indicates where on the reference view the current map view
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is situated. For instance, if the reference view shows the entire state of California,
and the Los Angeles area is currently shown in the map window, a flashing box
appears on the reference view outlining the Los Angeles area within the image of
California.

You can designate one of the saved views to be your “entry view.”  When an
entry view is set, MARPLOT will go to that view automatically upon starting up.

In the view dialog boxes, you have options as to which views you want to list,
and how you want to order them. If your MARPLOT system is multi-user you
have the choice of listing only those views saved by you, or including also the
views shared among all users of the system. Use the “include shared views” box
to make this choice. You can sort the listed views either alphabetically by the
name of the view, or alphabetically by the name of the map the view is
associated with. Use the “sort by name” and “sort by map” buttons to make this
choice. Also, if the list of views is long, you can type the first few letters of a view
name in the box at the top of the window and use the Find Next button to locate
the desired view in the list.

4.4.1   Go to View

Go to View is used to return to a previously saved view.

The Go to View dialog box appears when you the choose the Go to View menu
item and also when you start MARPLOT if you have not set an entry view.

The views listed include all the views that have been saved using Save Current
View, plus one <entire map> view for each map that has a Places layer (these are
usually the county maps derived from TIGER data). Unlike other views, the
<entire map> views do not have miniature images associated with them.

Select a view by clicking its name in the list. The miniature image of the view is
displayed in the lower-left part of the dialog box. Double-click the view name or
click the Go To View button to go to the view.

When the “Resize map window to fit view” box is checked, MARPLOT will
change the size of the map window on the screen to match the aspect ratio
(width to height) of the window at the time the view was saved. This is useful if
you want to be sure that what is in the window when you return to the view is
exactly what was in the window when you saved the view (actually, such a
guarantee is impossible, since the object or layers might have changed since the
view was saved). On the other hand, sometimes this extra precision might not be
worth the cost of having the map window change size automatically, and you
will want to leave this box unchecked.

The Map List button brings you to the Map List dialog box. From the Map List
dialog box, you can determine exactly which maps MARPLOT is aware of, and
which are in use. From the Map List, you can go to the “view” of a map; that is,
the rectangle that encompasses the map.
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4.4.2   Go to Previous View

When you change your view by any means (e.g., zooming in or out, or going to a
view with the Go to View menu item) you can return to what you were looking
at before by using this menu item.

4.4.3   Set Scale

This menu item and dialog box are used to set the viewing scale by entering the
scale value by hand.

You can enter the scale in any of the three formats presented. The two other
formats change to match the one you modify.

NOTE: There are other ways to change the viewing scale, without having to type
in numbers. For instance, the zoom tools and some of the other items in the View
menu change the viewing scale.

4.4.4   Go to Lat/Long

This menu item allows you to enter a latitude/longitude point by hand, and then
centers the map about that point. The default lat/long values presented when the
dialog box comes up are the coordinates of the Focus Point.

4.4.5   Center on Focus Point

This menu item changes the view, without changing the scale, so that the Focus
Point is in the center of the screen.

The Focus Point is the small, flashing target-shaped icon, , that marks the
location of the most recent point of interest on the map. Every time you click on
the map with the arrow tool, the Focus Point moves to the location of your click.
The Focus Point also changes in response to other operations, such as when you
show an object from the Search Collection on the map.

4.4.6   Save Current View

This menu item is used to add the view that is currently in the map window to
the list of saved views.

You are asked to name the view, and to pick the map with which the view is
associated. You can only associate a view with a map that intersects at least part
of that view. It is not crucial that you associate the view with the “correct” map
since the map name is used for reference purposes only and can be changed at
any time using the Edit Views menu item.
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If you have edit-level permission, you have the option of allowing the saved
view to be shared with other users of your system. If you want to do so, click the
“shared view with other users” box.

4.4.7   Edit Views

This menu item and dialog box allow you to make changes to the list of saved
views.

If you have edit-level permission, you can delete or rename views that you have
saved.

Renaming a view also gives you a chance to associate it with a different map.

4.4.8  Entry View

This menu item and dialog box let you pick a saved view as your entry view.

There are actually three options regarding the entry view.

1) You can choose to have no entry view (click the No Entry View button), in
which case each time MARPLOT starts up it will present you with the Go
to View dialog box to choose a starting view.

2) You can choose a particular saved view as the entry view (highlight the
desired view and click the Set Entry View button), in which case
MARPLOT will go to the designated view when it starts up. The entry
view is displayed in the list of views with a small “E” to the left of its
name. Note that the list of possible entry views includes those views that
have been saved with Save Current View, plus one <entire map> view for
each map with a Places layer.

3) You can click the “enter to last view from previous MARPLOT session”
box, in which case MARPLOT will always start at the last view you were
looking at the last time you were using MARPLOT.

4.4.9  Reference View

Use this menu item to show and hide the reference view inset, and to pick the
view to be shown as a reference view.

Select the view you want to use as a reference view and click Set Reference View.

In most cases, you will want to restrict your choice of reference views to those
views that encompass the current map view. The idea is that a reference view is
generally supposed to cover an area that contains the area of the main view,
since the point of the reference view is to show you where the main view is in
relation to a larger area. It isn’t helpful, for instance, if the reference view is
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showing County A but in the main view you are zoomed in somewhere in
County B.

However, there may be times when you want to set a reference view to a view
that does not quite encompass the main view. For instance, your main view
might be showing the very edge of your map, and you may want to use a
reference view that ends at the edge of the map. In this case, you can check the
“allow any view in reference” button.

Normally, you will want to keep this button unchecked to avoid the mistake of
having a reference view that does not contain the main view. When the button is
unchecked, MARPLOT will only allow you to choose a reference view that
contains the current main view. Furthermore, as you zoom out, MARPLOT will
automatically enlarge the reference view, if possible, to keep the main view
enclosed within it.

4.4.10  Legend

Use this menu item to show and hide the legend inset, and to activate the legend
panel of the Preferences dialog box to change the legend settings.

4.4.11  Scale Bar

Use this menu item to show and hide the scale bar inset, and to activate the scale
bar panel of the Preferences dialog box to change the scale bar settings.

4.4.12  Time Stamp

Use this menu item to show and hide the time stamp inset, and to activate the
time stamp panel of the Preferences dialog box to change the time stamp settings.

4.4.13  Lat/Long Grid

Use this menu item to show and hide the latitude/longitude grid on the map
window, and to activate the latitude/longitude panel of the Preferences dialog
box to change the grid settings.

4.4.14   Marked Point

The Marked Point, , serves as a reference location. It is useful for measuring
distances when the endpoints of the segment measured are not both visible in the
map window. It is also sometimes used when editing polyline objects such as
roads.

You can position the Marked Point either by using the Mark Focus Point item in
the Marked Point submenu of the View menu, or by using the Mark Vertex item
in the Vertex submenu of the Objects menu. You can only mark a vertex after
you have clicked with the arrow tool to select a polyline or polygon object.
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When you choose Mark Focus Point, the Marked Point is positioned at the
current location of the Focus Point. When the Focus Point subsequently moves,
the Marked Point retains the position at which it was set and only moves when
you explicitly set it to a different location.

When you choose Mark Vertex, the Marked Point is positioned at the vertex of
the selected polyline or polygon object that is closest to the Focus Point.

When the Marked Point is set, its latitude/longitude coordinates appear at the
bottom of the window.

Once you have positioned the Marked Point, there are four operations you can
perform with it. Three of these operations are in the Marked Point submenu of
the View menu. Center on Marked Point changes the view, without changing the
scale, so that the Marked Point is at the center of the map window. Distance to
Focus Point displays the distance from the Marked Point to the Focus Point in the
current units (see the Preferences menu item). Rescale to Marked & Focus Pts
shifts the map and sets the scale such that the Marked Point and the Focus Point
are both just visible at the edges of the window.

The second item in the Vertex submenu, Move Vertex to Marked Point, is used
when you want to position a particular vertex point of a given polyline or
polygon at an exact latitude/longitude point. This operation, in conjunction with
Mark Vertex, is especially important when editing intersecting road segments in
MARPLOT, since MARPLOT only considers roads to intersect when they have a
common vertex. For example, suppose you have created two roads called A and
B. You intend for them to intersect, but as you use the polyline tool to create
them in MARPLOT, you do not have the accuracy to ensure that a vertex of A is
in the exact same location as a vertex of B. To force the vertices to line up, you
can click near the desired vertex of road A and choose Mark Vertex. Then click
near the matching vertex of road B and choose Move Vertex to Marked Point.
That vertex of B is shifted so that it exactly coincides with the marked vertex of
A. Now MARPLOT considers the two roads to intersect. See section 5.4 for a
step-by-step example of this technique.

When you use Clear Marked Point in the Marked Point submenu, the Marked
Point disappears from the screen and its latitude/longitude coordinates are no
longer displayed.

4.4.15   Redraw

The drawing of a large view can be time-consuming. You can interrupt the
drawing by pressing the ESC key or by clicking anywhere on the map with the
mouse. This causes the drawing to stop and allows you to perform operations on
a partially drawn view. You can then use the Redraw menu item to force the
same view to be redrawn completely.
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NOTE: When you cancel the drawing of a view, MARPLOT behaves as if all of
the objects are there on the screen. For instance, you can click on the “invisible”
objects to select them. Similarly, any objects that were selected before the view
was drawn will be remain selected when you cancel the drawing, even if they
didn’t actually get drawn.

HINT: If you find you are frequently having to stop the drawing of a map,
consider using the Layer List dialog box to set the viewing scale of certain layers
to keep them from drawing when you are zoomed out too far.

4.5   List menu

This menu contains items for searching and using the resulting Search Collection
(the list of found objects).

It is also used to access the list of layers and the list of maps.

4.5.1   Search

The Search Criteria dialog box, which comes up when you select the Search
menu item, is used to find objects according to various criteria you specify.

There are three types of criteria that you must specify to do a search:

1) What type of search do you want to do?  In the pop-up box following the
words “Search for objects that:” there are seven choices for the type of search:

a) “have any name”  This choice indicates that you want all objects on the
specified maps and layers. Use this option with some caution since you
can easily specify several thousand objects — perhaps more than
MARPLOT will be able to list on your system.

b) “have names that start with...”  In this case, you type the first few
letters of the name of the object(s) you are looking for in the box to the
right of the pop-up. DO NOT type a directional prefix in the box. For
instance, if you are looking for “E Cedar St.”, just enter “Cedar.”

c) “have names that contain...”  In this case, you type letters that are to be
found somewhere within the name of the object(s) you are looking for.
This type of search is usually more time-consuming that using the
“with names that start with...” option. As with the “names that start
with...” option, DO NOT type a directional prefix in the box.

d) “are within...”  Here you want to find all objects that are within a
specified distance from the Focus Point, from the Marked Point (if it is
set), or from another set of objects. In this case, you enter the desired
distance, including the units, and choose as the reference the Focus
Point, the Marked Point, the set of currently selected objects, or the set
of objects in the previous search collection (i.e., those found in the
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previous search or the previous Copy to Search Collection operation).
This type of search can be time-consuming, so you will want to use it
carefully, and be as specific as possible about the layers and maps to be
searched.

e) “are not within...”  This is similar to the “are within...” option, except it
finds objects that are NOT within the given distance from the given
reference.

f) “are inside of or touched by...”  Here you want to find all objects that
are touched by the Focus Point, the Marked Point (if it is set), or
another set of objects, where for polygon, rectangle, or circle objects,
touching can mean being completely or partially inside the borders.
For example, finding all objects that “are inside of or touched by...” a
given polygon object will find objects completely or partially inside the
polygon. This search is the same as finding all objects “are within...” 0
miles of the given reference.

g) “are outside of and not touched by...”  This is similar to the “are inside
of or touched by...” option, except it finds objects that are NOT inside
of or touched by the given reference.

2) Which layers do you want to search?  In the pop-up box following the words
“Layer(s) to search:” there are three choices:

a) “All Layers”  This indicates that you want to search all layers. You
would use this when you are unsure which layers the desired objects
might be found on.

b) “Multiple Layers...”  Here you want to search on more than one layer,
but instead of simply choosing “All Layers,” you want to explicitly
check each layer to be searched. In this case, a small scrolling box
appears in which you can click on the names of the layers you want to
search. A check appears to the left of the names of the clicked layers.
Clicking a checked layer removes the check. Clicking in the “all layers”
box checks or unchecks all layers. Note that you must check at least
one layer to perform a search.

c) “Individual Layer...”  Here you know that the desired object is to be
found on a given layer. In this case, a second pop-up box appears in
which you can select the layer to be searched.

You may note that in the list of layers presented in the pop-up box,
layers with names such as “Roads (Major)” are not included. Instead,
just the layer “Roads” appears. For the purposes of searching, it is
assumed that when you want to search “Roads,” you also want to
search “Roads (Major).”  The same holds true for any layers whose
names are the same except for a word in parentheses.
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3) Which maps do you want to search?  In the pop-up box following the words
“Map(s) to search:” you have three choices:

a) “All Maps”  This indicates that you want to search all maps that are
currently available. You would use this when you don’t know (or
don’t want to spend time thinking about) which maps the desired
objects are to be found on. In many cases, there is no noticeable loss of
efficiency when using this option. However, if you are searching on a
layer such as “Roads” and have a number of maps with many roads,
the search is much more efficient if you can specify the map(s) to be
searched.

b) “Maps in View”  This is the most common setting. Here you want to
search only the maps that are shown (at least partially) in the current
view. The idea is that if you are currently looking at the map of, say,
LA County, it is likely that you want to search for an object on that
map. An important note about the “Maps in View” option is that many
maps are always considered to be “in view.”  In fact, only those maps
that have a “Places” layer (which in most cases means those maps
derived from Census TIGER files) are ever considered to be not in
view. All other maps, such as your user’s map, are always in view,
even when no objects on these maps are visible on the screen. Thus, the
“Maps in View” option can be thought of as “all maps, except those
maps with a Places layer that are not in view.”

c) “Selected Maps...”  Here you know exactly which map(s) you want to
search. In this case, a small scrolling box appears in which you can
click on the names of the maps to be searched. A check appears to the
left of the names of the clicked maps. Clicking a checked map removes
the check. Clicking in the “all maps” box checks or unchecks all maps.
Note that you must check at least one map to perform a search.

Once you have specified all the necessary criteria, click the Search button to
execute the search. While MARPLOT performs the search, it displays messages
at the bottom of the map window. If the search is taking too long, you can press
the ESC key to stop it, in which case the incomplete results of the search are
displayed.

When the search is complete, the objects found to match the specified criteria are
put into the Search Collection, and the Search Collection dialog box is shown.

In most cases, you will want to replace any previous contents of the Search
Collection (i.e., the results of the previous search) with the new list of found
objects. This is reflected by the “replace previous collection” choice at the bottom
of the Search Criteria dialog box. However, sometimes you may want to keep the
contents of the previous Search Collection, but add the newly found objects to
the list. In this case you would choose the “add to previous collection” option.
Finally, there may be times when you want to search based on the given criteria,
but only include objects that were already in the previous search collection (i.e.,



Chapter 4: Reference

66

you want to find a subset of the previous search collection). In this case, you
would choose the “subsearch of previous collection” option.

Search Collection dialog box

This dialog box displays the list of objects that resulted from the most recent
search, or from the most recent use of the Copy to Search Collection menu item.

The objects are listed in alphabetical order. You can move quickly to a certain
part of the list by typing the first few letters of the name you want.

Each object in the list is displayed with its name, the name of its layer, and its
place or map name. If the object is in a particular place that is included on the
“Places” layer of its map, that name will be used. For instance, the place might be
“Seattle city.”  If the object is not classified as being in a place on the “Places”
layer, the name of its map will be used. If the object is classified as being in a
place, but is also in other places, the name of the place will end with “...” as in
“Seattle city, ...”

When an object in the list appears in italic type and its name is followed by
another name in braces, it means the name is an alternative name for the object
whose name is in braces. For instance, if you see “Main St. { State Hwy 1 }” in
italics, it means that the object named “State Hwy 1,” or at least some section of
it, is also called “Main St.”  Thus, the “Main St.” object is not actually an object in
its own right, but just a reference to the true object, “State Hwy 1.”  Such
references are called aliases in MARPLOT. The Search Collection dialog box
shows the total number of aliases, along with the total number of real objects, at
the top.

When checked, the “make all other objects on these layers invisible” checkbox
hides all objects not included in the Search Collection. This checkbox is
automatically unchecked when a new search is performed.

When you have highlighted an object in the list, you can show the object on the
map by clicking the Show on Map button. The map is redrawn and shifted if
necessary to show the selected object. If you click the Show on Map & Zoom
button, when the object is shown the scale of the map will change so as just to
encompass the object in the map window. This is especially useful when the
object to be shown is a boundary-type object such as a city or county boundary.

Alternatively, you can click the Show All on Map button, in which case all objects
in the Search Collection will be selected and shown on the map. The view is
rescaled if necessary to include all of the objects.

For certain objects, you can also click the Addresses or Intersections buttons to
get a list of the address ranges or intersections for the selected object.

In some cases, you may want to save the list of objects in the Search Collection to
disk, so that you can use them again any time in the future. You can do this using
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the Save Collection button. You are prompted for a file name to save the Search
Collection into. This file has an extension of “MSC” for MARPLOT Search
Collection. Note that MARPLOT provides a folder (directory) called SEARCHES
as a convenient place to store your saved search collections. If your MARPLOT
system is multi-user, each user has his or her own SEARCHES folder (directory).

To retrieve a previously saved Search Collection, use the Load Collection button.
The loaded collection can replace, be combined with, or serve as a filter on the
current search collection, depending on your choice at the bottom of that dialog
box.

Click Close when you are done working with the Search Collection.

Intersections dialog box

This dialog box lists the objects that intersect the object highlighted in the Search
Collection.

NOTE: For the purposes of this dialog box, MARPLOT only considers two
polyline objects to intersect if they share a vertex exactly. Thus, if you simply
draw two polylines that cross one another, they will most likely not intersect
according to this dialog box, even though they cross each other on the screen.
This dialog box is intended for finding intersections in polyline data that has
been imported from an external source, such as the TIGER/Line database, where
intersecting polylines always share a vertex. If you want to find intersections
with arbitrary data, you can do so using MARPLOT’s Search function with a
“within” or “touching” option. Searching in this way is more flexible, but
significantly slower than, this intersection function.

As with objects in the Search Collection dialog box, the intersections are listed
with their names, the names of their layers and the names of their place or map.

When you have highlighted an intersecting object in the list, you can show the
intersection on the map by clicking the Show on Map button. The map is
redrawn and shifted if necessary to show the point of intersection. The Show on
Map & Zoom button shows the intersection at a scale that is appropriate for
viewing typical road intersections.

The check box labeled “Intersect with all layers” is used when you want to find
intersections between objects on different layers. For instance, suppose you want
to find the places where a road intersects with various rivers. You would select
an objects on the “Roads” layer in the Search Collection dialog box and click the
Intersections button. By default, only the intersecting objects from the “Roads”
and “Roads (Major)” layers will be included in the list of intersections. But if you
check the “Intersect with all layers” button, intersecting objects from all layers
will be included. Thus, any river objects on the “Water” layer that intersect the
road will be in the list.
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NOTE: As mentioned above, MARPLOT treats the “Roads” and “Roads (Major)”
layers as being the “same” layer as far as intersections are concerned, so you do
not have to check the “Intersect with all layers” box to find the intersection
between a road and a major road. Whenever two layers have names that differ
only by a suffix in parentheses, MARPLOT intersects them with each other
automatically.

Addresses dialog box

This dialog box lists the address ranges for a street.

When you have highlighted an address range in the list, you can show the
segment of the street that corresponds to that address range by clicking the Show
on Map button. The map is redrawn and shifted if necessary to show the chosen
segment. The Focus Point is placed on the center of the chosen segment, so that
you can identify it.

The Show on Map & Zoom button shows the address range at a scale that is
appropriate for viewing typical road segments.

4.5.2   Show Search Collection

This menu item returns you to the Search Collection dialog box, which displays
the list of objects that resulted from the most recent search, or from the most
recent use of the Copy to Search Collection menu item.

The Search Collection dialog box is described further in section 4.5.1.

4.5.3   Copy to Search Collection

Often the set of objects that is currently selected on the map is meaningful to you.
For instance, suppose you have selected the 20 objects on your “Schools” layer
that fall within a certain circle. You can easily find the names of the selected
objects by copying them to the Search Collection using this menu item. The new
Search Collection is then displayed, listing the schools by name.

Once the selected objects are in the search collection, they will stay there, even
after they are no longer selected, until the next time you explicitly modify the
Search Collection by doing a search or another Copy To Search Collection.

4.5.4   Layer List

This dialog box presents a list of all the layers. The layers can be listed either in
alphabetical order or in their top-to-bottom order, with the top-most layer at the
top of the list. The top-to-bottom order of the layers is important because the
layers are drawn in order from bottom to top. Thus, objects on higher layers can
be drawn over objects on lower layers. Similarly, when you click on the map at a
location with objects from more than one layer, the object from the highest layer
will be selected.
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For each layer, the list gives several columns of information. You can click on any
of these columns to change the settings for the given layer. The columns, from
left to right, are as follows:

1) The layer’s lock status. At the start of each MARPLOT session, every
layer is locked, indicated by a closed padlock icon, . When a layer is
locked, you cannot make any changes to the objects on that layer, such
as moving the objects, renaming them, or changing their color. To
unlock a layer, click its lock icon, . When you have unlocked one or
more layers, the list of tool icons on the left edge of the map window is
extended to offer tools for creating new objects. Although all users can
unlock layers, users without browse-level permission are restricted to
editing those layers on their personal user’s map only. You must have
edit-level permission to edit other maps. NOTE: When the lock icon for
a layer is gray instead of black, , it indicates that the given layer has
been locked by another application sharing information with
MARPLOT. In effect, the layer is “owned” by that application. You can
unlock such a layer, , but the changes you can make to objects on
that layer are restricted to those made by the use of the graphical menu
items in the Objects menu.

2) The layer’s name. Clicking on a layer’s name simply highlights the
layer in the list. If a layer’s name appears in italics, it indicates that the
layer is temporary, meaning that all objects on the layer will be deleted
when the current MARPLOT session is terminated.

3) “Show + Names”  Clicking in this column means that you want to turn
the layer on (i.e., show the objects on the layer), regardless of the map
scale. Further, you want the objects to be labeled with their names,
regardless of the map scale.

4) “Show”  Clicking in this column means that you want to turn the layer
on (i.e., show the objects on the layer), regardless of the map scale. The
objects will only be labeled with their names at certain scales, as set by
the Layer Scale Ranges dialog box.

5) “Range”  Clicking in this column means that you want to turn the layer
on (i.e., show the objects on the layer) only within the range of scales
set by the Layer Scale Ranges dialog box. Similarly, the objects will
only be labeled with their names at certain scales, as set by the Layer
Scale Ranges dialog box.

6) “Hide”  Clicking in this column means that you want to turn the layer
off (i.e., not show the objects on the layer), regardless of the map scale.
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7) “Default Graphics”  Clicking in this column, , represented at the
top by a pair of identical symbol icons, means that you want all objects
on the layer to be drawn using the default graphical settings for the
layer, as set using the “Default graphics” control in the boxed area
below the list of layers. This gives the objects on the layer a uniform
look, and also allows you to change the look of all objects on the layer
simply by changing the default graphics for the layer. Note that in this
column, instead of a check mark, a small sample of the default
graphics for the layer is displayed.

8) “Individual Graphics”  Clicking in this column, , represented at
the top by a pair of icons that are not identical, means that you want
the objects on the layer to be drawn using their individual graphical
attributes, as set by the Object Settings dialog box. In this case, the
“Default graphics” for the layer are not used, and the objects on the
layer may look very different from one another (although typically
most or all of the objects on a layer will have identical individual
graphical attributes and will look the same).

There is a small button at the top of each of the last six columns. Clicking this
button is the same as clicking in the given column for all layers. For instance, if
you wanted to quickly hide all layers except one, you would click the small
button at the top of the “Hide” column to hide all layers, then click in the “Show”
column of the desired layer.

The boxed area just below the list of layers gives information specific to the layer
that is currently highlighted in the list. You can use this area to:

1) View how many objects are on the layer, and how many maps the
layer is represented on.

2) Use the “Rename” button to give the layer a different name.
WARNING: Renaming a layer can cause trouble when you have
previously linked objects on that layer to database programs since the
database program’s link to the object involves the name of the object’s
layer. As a rule, you should only rename layers that you have created
by hand yourself.

3) Use the “Move Layer...” button to move the layer up or down in the
list of layers. This option is only available when the layers are listed in
top-to-bottom order (i.e., when the “alphabetical” box is not checked).

4) Use the “Scale Ranges...” button to set the scale ranges for the layer.
See the description of the Layer Scale Ranges dialog box below.

5) Use the “Set” button to set the default graphical attributes for the layer.
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NOTE: The line width setting is also used as the setting for the size of
the dots, when symbol objects on the layer are shown as dots,
according to the Layer Scale Ranges dialog box.

NOTE: By default, in the “Default Graphics” column of the list of
layers, a small symbol icon is displayed to show a sample of the look of
objects on that layer. However, some layers contain predominantly
objects that are not symbols (points) but polylines or polygons. For
instance, a “Roads” layer would contain only polylines and a
“Counties” layer would contain only polygons. With such a layer, you
can choose as the “default symbol” either the polyline or polygon
symbol that appear near the start of the table of symbols. When one of
these is chosen as the default layer symbol, MARPLOT draws a small
polyline or polygon instead of a small symbol in the layer’s “Default
Graphics” column in the layer list. Similarly, when the default line
pattern is chosen to be the railroad pattern, MARPLOT draws the
railroad pattern instead of a symbol in the “Default Graphics” column.

You can use the New and Delete buttons to create or delete layers. You must
unlock a layer before attempting to delete it. Usually, you will only create and
delete layers that you intend to use on your personal user’s map.

WARNING: Deleting a layer deletes all objects on that layer. This can cause
trouble when you have previously linked objects on the layer to database
programs, since the database program might consider a linked object to exist
even though it has actually been deleted.

Layer List groups

Layer groups give you a way to group layers in the Layer List in order to view
and operate on them more conveniently.
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A layer group is just a collection of layers. You create a layer group by clicking
the New... button in the Layer List (you are given the choice of creating a new
layer or a new group). Move a layer into a group by highlighting the layer and
selecting Into Group... from the Move pop-up menu. Move a layer out of a group
by highlighting the layer and selecting Out of Group from the Move pop-up
menu.

A layer group can be opened or closed. Close the group by clicking on the black
triangle to the left of its name. Click on the triangle again to re-open the group.
The layers in a closed group are treated just like other layers; they are just hidden
from view in the Layer List. The downward-pointing triangles at the tops of
columns of an open group can be used to set all of the layers in the group with a
single action. For instance, clicking in the triangle in the Show column puts all
layers in the group into show mode.

To set the scale ranges or default graphics for all layers in a group
simultaneously, highlight the group name and use the Scale Ranges… button or
default graphics pop-up menu.

Deleting a Layer group will delete those layers it contains that have no objects.

The layers which contain objects are retained in the Layer List.

Layer Scale Ranges dialog box

The purpose of this dialog box is to allow you to set four scale values related to
the display of the given layer (or group). The dialog box presents a scale “ruler”
that ranges from a largest (most zoomed-in) scale of “1 inch = 0.01 mi” to a
smallest (most zoomed-out) scale of “1 inch = 4137 mi”. To visualize the scale
ruler, you might imagine that you are in a helicopter. At the bottom of the scale
ruler, you are very close to the earth and can only see a small amount of land. As
you rise higher and higher you see more and more land, until you reach a height,
at the top of the scale ruler, where the entire earth is within view.

The four scale values that you can set for the given layer are:

1) The “Show Layer” scale value, . This value applies only when
the layer is in “Range” mode, as set in the Layer List dialog box. It
specifies the smallest (most zoomed-out) scale at which the given layer
is to be shown (turned on). At all smaller (more zoomed-out) scales,
the layer will be hidden (turned off).

2) The “Hide Layer” scale value, . This value applies only when the
layer is in “Range” mode, as set in the Layer List dialog box. It
specifies the largest (most zoomed-in) scale at which the given layer is
to be shown (turned on). At all larger (more zoomed-in) scales, the
layer will be hidden (turned off).
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3) The “Show Names” scale value, . The value applies only when
the layer is in “Show” or “Range” mode, as set in the Layer List dialog
box. (When the layer is in “Show + Names” mode, the names are
shown regardless of the scale.)  It specifies the scale at which name
labels for objects on the layer are to be drawn on the map. The names
appear at the given scale and at all larger (more zoomed-in) scales. The
purpose of this scale setting is to allow you to show names of objects
only at scales where they do not crowd each other out on the screen.

4) The “Icons -> Dots” scale value, . This value specifies the scale at
which symbol (point) objects on the layer are to be drawn as small dots
instead of as their usual symbol icons. Symbols will be drawn as dots
at the given scale and at all smaller (more zoomed-out) scales. The
purpose of this scale setting is to allow you to show symbols as dots at
scales when the symbols icons would crowd each other out on the
screen.

The four scale values are represented as lines to the right of the scale ruler. Each
line has a small arrow pointing at a mark on the scale ruler, the name of the scale
value to be set, and the current setting for that scale value.

You can change any of the four layer scale values by clicking on the name of the
desired scale value and dragging up or down. The scale value follows the
movement of the mouse until you release the button.

The scale of the map’s current view in the map window is indicated to the left of
the scale ruler. This is a useful reference point when setting scale values. For
instance, you might be looking at the map and think, “At this scale, it takes too
long to draw all of the objects on my Roads layer.”  You could then use the Layer
Scale Ranges dialog box to change the scale ranges for the Roads layer. You
would know to drag the “Show Layer” scale value somewhere below the current
scale marker on the scale ruler.

When you are satisfied with the scale values for the layer, click OK.

4.5.5   Map List

This dialog box lists all of the maps known to MARPLOT. It allows you to
modify the status of existing maps, add maps to the system, or remove maps
from the system. More information on the management of maps can be found in
section 2.4.

The Map List shows, for each map, the name of the map, the map’s folder
(directory) on the disk, the “status” of the map, and the number of layers the
map contains.

Maps can be in one of three states: In Use, Not In Use, or Not Found. Maps that
are In Use are drawn on the screen and can be operated on using all of the
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MARPLOT functions. Maps that are Not In Use are not drawn on the screen.
Maps are Not Found when you have renamed or deleted a map folder that
MARPLOT had used during a previous session. A map might also be Not Found
because it is on a removable disk that is not currently mounted. NOTE: If a map
is Not Found because its disk is not mounted, you must quit MARPLOT, insert
the disk, and then restart MARPLOT in order for the map to be found.
MARPLOT will not find a map on a disk that is inserted while MARPLOT is
running.

You can sort the maps either by name or by path. Sorting by path is useful when
you have many maps that are organized hierarchically in folders (directories).
Click the small circles to the left of the “Name” and “Path” labels to change the
sort order.

When there are many maps, you can find a map in the list by typing a few
characters of its name into the “Find” text box and clicking Find Next.
Repeatedly clicking on Find Next finds all maps containing the given string of
characters.

You can get more specific information about the selected map using the Map Info
button, which brings up the Map Info dialog box.

You can use the Go to Map button to change the view in order to encompass the
area of the selected map (the area encompassing all objects on the map).

You can rename the selected map using the Rename button. WARNING:
Renaming a map can cause trouble when you have previously linked objects on
that map to database programs since the database program’s link to the object
involves the name of the object’s map. You will rarely want to rename a map.

The Find New Map button is used when you have a map folder (directory) that
you want to add to the list of maps. You can find a map on one of your hard
disks or on any other data storage device. Pick the map by locating the file that
ends in “.MAP” within the map folder you want to add to the map list. Click the
Open button to add the map. See section 2.4.3 for information on using CD maps.

In a multi-user MARPLOT system, the Find New Map operation is usually
performed by the system administrator.

Once you have added a map to the list using Find New Map, MARPLOT will
remember it and look for that map each time it starts up. If at some later time you
no longer want the map in the list, use the Remove button to remove the map
from the list.

MARPLOT automatically looks for maps within its own folder (directory) when
it starts up. Thus, you can add a map without using Find New Map by putting
the map folder into the MARPLOT folder and restarting MARPLOT. You cannot
use the Remove button to remove maps in the MARPLOT folder; you must move
the map directory outside of the MARPLOT folder in order to remove the map
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from the list. Also, you cannot remove a map that is “owned” by another
application while that application is running.

The Remove button does not delete the map’s files on disk but simply erases
MARPLOT’s “knowledge” of the map. NOTE: In a multi-user MARPLOT
system, any maps added by the system administrator using the Find New Map
button are automatically added to the map lists of all users. If the system
administrator has added certain maps in this way, only he or she can remove
them permanently; other users can remove them for the current MARPLOT
session only.

SHORT CUT: You can toggle a map between In Use and Not In Use by clicking
on the map’s row in the Status column while holding down the control key (the
option key on the Macintosh).

Map Info dialog box

This dialog box shows the name and folder (directory) of an individual map, and
lets you change certain settings for that map.

You can click the “use this map” box to put the map In Use or Not In Use.

Each map has a five-digit “default location code.”  When you create an object on
a map, the object inherits its location code from the map. The location code is not
used by this version of MARPLOT, but it may be used in a future version. For
now, you will probably want to leave the “default location code” field
untouched.

The list in the center of the dialog box shows you which layers are included in
this map, and how many objects from this map are on those layers.

4.6   Objects menu

The items in the Objects menu are used when you have one or more objects
selected and want to get MARPLOT information about them or modify them in
some way. You can get detailed information about a single object, including
information specific to a single segment of a polygon or polygon object. You can
modify the selected objects by changing their graphical attributes, or by moving
them to a different layer or map.

NOTE: The Objects menu only affects the objects that are currently selected, and
does not apply to other objects, including those created in the future. For
instance, if you create an object whose color defaults to red (because red is the
default color for its layer) and then change that object to green using the Objects
menu, future objects created on that layer will still default to red (until you
change the layer’s default color).
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4.6.1   Object Settings

This dialog box allows you to change the settings of an individual object. It
appears automatically to let you check/modify the settings for a newly created
object. It also appears when you select a single object on the map and use the
Object Settings menu item, or when you double-click on an object on the map.

The top portion of the dialog box is the same for all types of objects. The lower
portion differs depending on the type of object.

In order to modify information about an object, the object’s layer must be
unlocked. Users with browse-level permission can only modify objects on their
private user’s map.

The first field lets you view/modify the name of the object.

The next two lines let you change the object’s map and layer. Changing an
object’s map is very rare, and is done only when an object has mistakenly ended
up on the wrong map. Changing an object’s map does not change its location,
but may extend map boundaries. You can change the object’s layer if it has been
“misclassified” on the wrong layer. Note that to move the object from one layer
to another, both layers must be unlocked. WARNING: Changing an object’s map
or layer can cause problems if the object has been linked to a database program.

The next box presents four pieces of information that are used to help track the
object:

1) Each object has a four-character owner code. This code is used to keep
track of who originally created the object. In a multi-user MARPLOT
system, the administrator can assign each user a unique code.
Otherwise, objects created by users have the default code “USER.”
Objects that are derived from Census Bureau TIGER files have the
owner code “CENS.”

2) Each object has a five-digit location code. This is used to keep track of
where the object is situated. Generally, this location code matches the
default location code of the map the object is on.

3) When an object is modified, the date of the modification is recorded.
This date is shown in the Modified field.

4) When an object is modified, the four-character code of the modifier is
recorded. This is the code assigned to each user in a multi-user
MARPLOT system, or the default value “USER.”

Each object is classified according to the Census Bureau’s feature classification
system. This system uses three-character codes and includes many types of
categories ranging from various types of roads to various types of institutions
such as hospitals and schools. In MARPLOT, this classification is used only for
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display purposes. You can change the classification of the object by using the Set
button next to the Class field.

Each object has a place, which is either the name of an object on the “Places”
layer, such as a city, or the name of the map that the object is part of. The place of
the object is used by MARPLOT for display purposes only. You can set the
object’s city or town with the Set button next to the Place field.

The Position/Size button brings up the Position/Size dialog box, which lets you
view/modify the latitude/longitude location of the object. The radius
measurements of circle objects may also be viewed/modified.

The remaining lower part of the dialog box varies for the different types of
objects, as follows.

For polygon, polyline, rectangle, and circle objects...

You can view/modify the color, line style, and fill pattern. Filling an object with
white means not filling it (i.e., leaving its interior clear). You cannot set the fill
pattern of polyline objects, since they have no interior.

For symbol (point) objects...

You can view/modify the color, dot width, and symbol. The symbol is the icon
used to represent the object on the map. The dot width is the size of the dot to be
used for this object when the objects on the given layer are shown as dots,
according to the Layer Scale Ranges dialog box. Note that setting the dot size
here is the same as setting the object’s Line Width in the Draw menu.

For text objects...

Click the Edit Text button to edit the text of the object. The text does not “wrap”
when displayed on the map, so you should use <enter> (<return> on Macintosh)
to create multiple lines, if desired. You can also view/modify the color, font, and
style of the text. When the “frame” box is checked, the text is drawn surrounded
by a frame and against a white background. When the “frame” box is not
checked, the text appears unframed, and there is no white background.

For picture objects...

A miniature image of the picture is shown on the right. The name of the file in
the map directory (folder) in which the picture is stored is displayed. When the
“frame” box is checked, the picture is drawn surrounded by a frame and against
a white background. When the “frame” box is not checked, the picture appears
unframed, and there is no white background.

The Geo-Reference button is used to position the picture on the earth by
specifying the latitude/longitude coordinates of one or two points on the picture.
This is useful when you have a large picture object that serves as “base maps”
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upon which other objects are placed. You will usually geo-reference a picture
object just once, right after you insert it, but you can correct its location by geo-
referencing it any time. Keep in mind, however, that if you have placed objects
“on” the picture object, and then shift the picture object, the objects will retain
their old position, which will be incorrect in relation to the new location of the
picture.

Geo-Referencing a picture object

The purpose of this dialog box is for you to specify two latitude/longitude points
on the picture object so that MARPLOT knows where it is situated on the earth.
You can either specify both points explicitly, or one point explicitly and the other
by giving its direction and distance from the first.

The four items in the upper-right corner of this dialog box serve as a miniature
tool palette. Click on the palette to choose one of these four tools. Use the plus
and minus magnifying glass tools (along with the scroll bars surrounding the
picture) to zoom in and out as you search for the two points you want to use.
Also, you can click on the miniature copy of your picture on the right side of the
dialog box to quickly move to any part of the picture. The moving rectangle in
the miniature view shows the area of the picture being displayed in the larger
view area.

When you find the location of your first point, choose the “1” tool and click its
point on the desired picture point (you might want to zoom in close to increase
your accuracy).

When you have clicked the point, it will be marked with a “1” on the picture and
you will be asked to enter the latitude/longitude values for the point.

Do the same for the second point using the “2” tool. With the second point, you
have the option of specifying the distance from point 1, instead of giving its
latitude/longitude coordinates directly.

If you are unhappy with one or both of your points, you can reposition them by
using the “1” and “2” tools again, or you can modify only the latitude/longitude
values by clicking the Reset buttons.

When you are happy with the points and the latitude/longitude values you have
entered, click the OK button. MARPLOT will change the position of the picture
object to fit the coordinates you have specified.

NOTE: In some cases, you might not need to geo-reference a picture object. You
may be able to achieve the desired accuracy simply by dragging and stretching
the object directly in the map window with the arrow tool.
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4.6.2   Segment Settings

This menu item and dialog box allow you to view and modify information
specific to an individual segment of a polyline or polygon object. To use the
dialog box, select a single polyline or polygon object on the map by clicking it
with the arrow tool along the desired segment. Then choose the Segment Settings
menu item.

The segment’s number is given, along with the total number of segments in the
object. Some segments, in objects derived from TIGER/Line data, are “shape”
segments of other segments. This means that the segment usually does not have
settings of its own but shares settings with some of its neighbors. In most cases,
you do not have to be concerned with whether a segment is a shape segment.

For segments that have address information, the address ranges on one or both
sides of the segment are displayed. You can modify the segment’s address ranges
if the selected object’s layer is unlocked.

For segments that have ZIP code information, the ZIP codes on one or both sides
of the segment are displayed. You can modify the segment’s ZIP codes if the
selected object’s layer is unlocked.

For segments that are derived from TIGER/Line data, the classification code of
the segment is displayed. This classification usually matches the classification of
the entire object to which the segment belongs, but this is not always the case.
You can modify the segment’s classification code if the selected object’s layer is
unlocked.

For segments that are derived from TIGER/Line data, the original TIGER/Line
identification number for the segment is displayed, along with the version of the
TIGER database the segment was derived from. This information is useful for
tracking changes you make to TIGER-derived objects.

When you are finished working with a given segment, you can exit the Segment
Settings dialog box with the OK or Cancel buttons, or you can use the Previous
and Next buttons as a quick way to browse through other segments of the
selected object.

4.6.3   Vertex Menu

The Vertex submenu contains four items that are used to move, insert, and delete
vertex points of polyline and polygon objects. All of these items apply only when
you have used the arrow tool to select a polyline or polygon object. They all
expect the Focus Point to be on or near the desired vertex point of the selected
object.

When you choose Mark Vertex, the Marked Point is positioned at the vertex of
the selected polyline or polygon object that is closest to the Focus Point. (For
more information about the Marked Point, see section 4.4.13.)



Chapter 4: Reference

80

Move Vertex to Marked Point is used when you want to position a particular
vertex point of a given polyline or polygon (the one currently closest to the Focus
Point) at an exact latitude/longitude point. This operation, in conjunction with
Mark Vertex, is especially important when editing intersecting road segments in
MARPLOT, since MARPLOT only considers roads to intersect when they have a
common vertex. For example, suppose you have created two roads called A and
B. You intend for them to intersect, but as you use the polyline tool to create
them in MARPLOT, you do not have the accuracy to ensure that a vertex of A is
in the exact same location as a vertex of B. To force the vertices to line up, you
can click near the desired vertex of road A and choose Mark Vertex. Then click
near the matching vertex of road B and choose Move Vertex to Marked Point.
That vertex of B is shifted so that it exactly coincides with the marked vertex of
A. Now MARPLOT considers the two roads to intersect. See section 5.4 for a
step-by-step example of this technique.

Insert Vertex at Focus Point is used to create a new Vertex in the selected object.
You can think of this operation as breaking the given segment into two pieces.
Each piece has the settings (address range, ZIP code, etc.) of the original.

Delete Vertex deletes the vertex of the selected object that is closest to the Focus
Point.

4.6.4   Move Objects to Layer

This menu item moves the selected object(s) from their current layer(s) to the
layer you select.

It is most commonly used when you want to change the layer of several objects
at once, such as when you are moving all objects from one layer to another layer.

To move an object from one layer to another, both layers must be unlocked.
Users with browse-level permission can only move objects between layers on
their private user’s map.

Note that you can also change the layer of an individual object using the Object
Settings dialog box.

WARNING: Changing an object’s layer can cause problems if the object has been
linked to a database program.

4.6.5   Move Objects to Map

This menu item moves the selected object(s) from their current map(s) to the map
you select.

It is most commonly used when you want to change the map of several objects at
once, such as when you are moving all objects from one map to another map.
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To move an object from one map to another, the object’s layer must be unlocked.

Users with browse-level permission cannot move objects from one map to
another.

Note that you can also change the map of an individual object using the Object
Settings dialog box.

WARNING: Changing an object’s map can cause problems if the object has been
linked to a database program.

4.6.6   Color

This menu item changes the color of the selected object(s) to the color you select.

The layer(s) of the selected object(s) must be unlocked. Users with browse-level
permission can only change objects on their private user’s map.

MARPLOT now has enhanced functionality for determining the color of an
object. From the Color menu, the user may select from 16 pre-determined colors
categories or the Other… category. The Other… category gives the user the
ability to create a custom color using standardized inputs.

Note that you can also change the color of an individual object using the Object
Settings dialog box.

4.6.7   Line Width/Pattern/Style

These items change the line style of the selected object(s) to the style you select.

On Windows, the Line Style menu item is present. On Macintosh systems, there
are two menu items relating to line styles: Line Width and Line Pattern. The Line
Style items lets you pick from among several thicknesses or patterns. The Line
Width and Line Pattern items allow you to combine any chosen thickness with
any chosen pattern.

The white or “Ø” line style only applies to polygon edges. If you set the line style
of a polyline to white or “Ø”, MARPLOT uses a solid pattern instead.

The layer(s) of the selected object(s) must be unlocked. Users with browse-level
permission can only change objects on their private user’s map.

Note that you can also change the line style of an individual object using the
Object Settings dialog box.

For symbol (point) objects, the width of the chosen line style determines the size
of the dot when symbol objects on the given layer are shown as dots, as set by
the Layer Scales Ranges dialog box.
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4.6.8   Fill Pattern

This menu item changes the fill pattern of the selected object(s) to the pattern you
select.

The layer(s) of the selected object(s) must be unlocked. Users with browse-level
permission can only change objects on their private user’s map.

Note that you can also change the fill pattern of an individual object using the
Object Settings dialog box.

4.6.9   Symbol

This menu item changes the symbol of the selected symbol (point) object(s) to the
symbol you select.

The layer(s) of the selected object(s) must be unlocked. Users with browse-level
permission can only change objects on their private user’s map.

Note that you can also change the symbol of an individual symbol object using
the Object Settings dialog box.

4.7   Sharing menu

As described in section 1.2.7, MARPLOT has the capability to share information
with other application programs, especially database programs that store
information about MARPLOT objects.

The programs work together by means of the Sharing menu. The Sharing menu
has a submenu for each application that MARPLOT communicates with directly.
For information about the items in the Sharing submenus, see the documentation
for the applications that “own” the submenus.

4.8   Tools

The MARPLOT tools appear as a list of icons along the left edge of the map
window. When you have unlocked one or more layers, the list of tools extends to
include tools for creating new objects on the map.

When you click on a tool icon, it becomes highlighted and your mouse cursor
changes to the corresponding tool when it is in the map window.

You can double-click on some of the tool icons (those marked with two small
arrows) to alter the behavior of the tools. For instance, if you double-click on the
arrow tool icon, you can choose whether dragging with the arrow selects using a
rectangular or circular area.
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4.8.1   Arrow tool   

Whenever you click on the map with the arrow tool, a small, flashing, target-

shaped icon called the “Focus Point,” , is placed at the location of the click.
The latitude/longitude coordinates of the Focus Point are displayed in the
upper-left corner of the map window.

The arrow tool is used to select, move, and resize objects on the map. You can
also double-click on an object with the arrow tool to get the Object Settings
dialog box for the object.

SELECTING OBJECTS: You select an object by clicking on it or near it. To select a
filled rectangle, circle, polygon, you click on any point inside or “near” the
boundary. To select a non-filled rectangle, circle, polygon, polyline, symbol, or
text object you click near the boundary. When an object is selected, it is
surrounded by small red markers (handles), and its name, layer, and map are
displayed at the bottom of the window. Hold down the shift key when selecting
objects to select more than one at a time. If you click on an already-selected object
while holding down the shift key, that object will become deselected.

You can select several objects in a given area by clicking with the arrow tool and
holding the mouse button down as you drag. The movement of the mouse
defines a region with a gray border. When you release the mouse button, you are
asked which layer(s) you want to select. All objects in the region and on the
chosen layer(s) then become selected.

MOVING OBJECTS: When you have selected one or more objects, you can move
them simply by clicking on any one and dragging the mouse with the button
down. Gray outlines of the objects follow your mouse movements. When you
release the button, the objects will move to the indicated location. You can only
move objects that are on unlocked layers. Users with browse-level permission
can only move objects on their private user’s map.

RESIZING OBJECTS: When you have one object selected, you can resize it by
clicking on one of its handles (the dots that surround the object to indicate that it
is selected) and dragging with the mouse. Symbol objects cannot be resized.
Picture and Text objects retain their shape as they are resized. You can only
resize objects that are on unlocked layers. Users with browse-level permission
can only resize objects on their private user’s map.

OPTIONS

When selecting a group of objects by defining a drag region with the arrow tool,
you have the option of using either a rectangular or a circular region. The
rectangular region follows the mouse starting at the corner of the rectangle while
the circular region follows the mouse from the center of the circle. You can
choose which shape will be used by double-clicking on the arrow tool icon. As a
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short cut, you can toggle between two types of selection regions by holding
down the option key.

If you hold down the control key (option key on Macintosh) when clicking on the
map, MARPLOT will ask you which layers you want to select on and then select
all objects on the chosen layers that are touched by the point at which you
clicked. This allows you to select several objects at the same location, regardless
of which ones are “on top” of the others, according to the top-to-bottom order of
the layers.

If the right mouse button (control key on Macintosh) is down at the time
MARPLOT displays an object’s name at the bottom of the window, the object’s
ID number is also displayed.

4.8.2   Hand tool   

The hand tool is used to scroll the map in the window. Click and drag with the
hand. When you release the button, the map shifts in the direction of your drag.

4.8.3   Zoom-in tool   

The zoom-in tool is used to zoom into the map by a factor of two or to zoom into
an area of the map by selecting that area as a rectangular region. When you click
with the zoom-in tool, the map is rescaled and centered about the location of the
click.

When you drag to select an area and release the mouse button, the view is
changed to show just the selected area. Note that, as you drag, the rectangular
selection region is constrained to match the dimensions of the map window.

OPTIONS: Double-click in the zoom-in tool in the tool palette to choose whether
the rectangle is defined by following the mouse from the top-left corner or from
the center of the rectangle. Hold down the control key (option key on Macintosh)
when using the tool to toggle between the two behaviors.

4.8.4   Zoom-out tool   

The zoom-out tool is used to zoom out from the map by a factor of two. When
you click with the zoom-out tool, the map is rescaled and centered about the
location of the click.
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4.8.5   Distance tool   

The distance tool (whose icon is a small ruler) is used to measure distances on
the map with the mouse. To use this tool, click on the map and drag while
holding the button down. The mouse movement defines a circle, with a radius
drawn from the mouse to the location of the initial click. The radius of the circle
is displayed at the bottom of the map window, in the current units (use the
Preferences menu item to change the current units).

MARPLOT also displays the angle of the radius line, where 0° is true north, and
the angle increases clockwise.

If you are measuring very large distances with the distance tool, MARPLOT will
stop drawing the circle (but continue to draw the length) at the point that the
curvature of the earth makes the circle unrealistic.

4.8.6   Symbol tool   

The symbol tool is only available when one or more layers are unlocked.

The symbol tool is used for creating symbol (also called “point”) objects.

As soon as you click to place the symbol, the Object Settings dialog box for the
new object pops up to allow you to change any of its settings. You should be
especially careful to make sure the object has been placed on the correct layer
and map. Click OK when you are happy with the settings for the new object, or
Cancel if you decide not to create the object after all.

4.8.7   Rectangle tool   

The rectangle tool is only available when one or more layers are unlocked.

The rectangle tool is used for creating rectangle objects. Note that a rectangle
object is always oriented so that its sides are vertical and horizontal. To create a
four-sided object that is rotated, you must use the polygon tool to create a
polygon object.

You create the rectangle by clicking with the rectangle tool on the map and
dragging. As soon as you let up on the mouse button, the Object Settings dialog
box for the new object pops up to allow you to change any of its settings. You
should be especially careful to make sure the object has been placed on the
correct layer and map. Click OK when you are happy with the settings for the
new object, or Cancel if you decide not to create the object after all.
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OPTIONS: When drawing the rectangle, you can treat the initial mouse click
either as the top-left corner or the center. You can use the control key (option key
on Macintosh) to toggle between the two, and you can set one or the other as a
default preference by double-clicking on the rectangle tool icon. Also, if you hold
down the shift key when drawing the rectangle, it is constrained to a square.

4.8.8   Circle tool   

The circle tool is only available when one or more layers are unlocked.

The circle tool is used for creating circle objects which represent or approximate
earth circles. Hence in some views large circles will appear on the screen as
ellipses because an earth circle is only approximated by an ellipse drawn to the
screen (i.e. they will match in the north, south, east, and west but not
everywhere).

You create the circle by clicking with the circle tool on the map and dragging. As
soon as you let up on the mouse button, the Object Settings dialog box for the
new object pops up to allow you to change any of its settings. You should be
especially careful to make sure the object has been placed on the correct layer
and map. The Position/Size button leads to a dialog box that gives the area,
perimeter (circumference) and radius of the selected circle object and lets you
view/modify the radius value and the latitude/longitude position of the center
of the circle. You can modify the position only when the object’s layer is
unlocked. NOTE:  Unless you need to place the object at an exact
latitude/longitude point, it is often easier to move the object by dragging it in the
map window with the arrow tool. Click OK when you are happy with the
settings for the new object, or Cancel if you decide not to create the object after
all.

OPTIONS: When drawing the circle, you can treat the initial mouse click either
as the top-left corner or the center. You can use the control key (option key on
Macintosh) to toggle between the two, and you can set one or the other as a
default preference by double-clicking on the circle icon.

4.8.9   Polyline tool   

The polyline tool is only available when one or more layers are unlocked.

The polyline tool is used for creating polyline objects, which are strings of
connected line segments used to represent things such as roads or rivers.

You define the polyline segment by segment, clicking at the end point of each
segment. Double-click on the final endpoint to finish creating the polyline. The
polyline terminates at the location of your double-click.
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As soon as you double-click, the Object Settings dialog box for the new object
pops up to allow you to change any of its settings. You should be especially
careful to make sure the object has been placed on the correct layer and map.
Click OK when you are happy with the settings for the new object, or Cancel if
you decide not to create the object after all.

Use the arrow tool, not the polyline tool, to move the vertex points of an existing
polyline object.

HINT: If you forget to double-click on the last point of your polyline, you can
finish the polyline without defining a new point by clicking once on the polyline
tool icon. (You can only do this after you have defined at least two real
endpoints.)

4.8.10   Polygon tool   

The polygon tool is only available when one or more layers are unlocked.

The polygon tool is used for creating polygon objects (multi-sided, closed
figures).

You define the polygon segment by segment, clicking at the end point of each
segment. Double-click on the final endpoint to finish creating the polygon. The
final segment connecting the final endpoint to the polygon’s starting point is
automatically filled in.

As soon as you double-click, the Object Settings dialog box for the new object
pops up to allow you to change any of its settings. You should be especially
careful to make sure the object has been placed on the correct layer and map.
Click OK when you are happy with the settings for the new object, or Cancel if
you decide not to create the object after all.

Use the arrow tool, not the polygon tool, to move the vertex points of an existing
polygon object.

HINT: If you forget to double-click on the last point of your polygon, you can
finish the polygon without defining a new point by clicking once on the polygon
tool icon. (You can only do this after you have defined at least three real
endpoints.)

4.8.11   Text tool   

The text tool is only available when one or more layers are unlocked.

The text tool is used for creating text objects to label your maps.
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Click on the map with the text tool to specify the center of the new text object.

As soon as you click, the Object Settings dialog box for the new object pops up to
allow you to change any of its settings. For new text objects, MARPLOT brings
up the Edit Text dialog box immediately to let you enter the text.

You should be especially careful to make sure the object has been placed on the
correct layer and map. Click OK when you are happy with the settings for the
new object, or Cancel if you decide not to create the object after all.
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5   Examples

5.1   Adding maps

Introduction

A MARPLOT map is a folder (directory) containing layer files. Layer files have
names that end with “.LYR,” “.SUM,” and “.OBJ” (in some cases there are also
files with names ending in “.SM2” and “.NNX”).

MARPLOT automatically adds to its map list any map folder (directory) that is
inside the MARPLOT folder (directory) at the time a MARPLOT session begins.

MARPLOT keeps a list of maps stored in locations other than the MARPLOT
directory in the file XTRAMAPS.PLT. When a MARPLOT session begins,
MARPLOT adds to its map list any map in this file that is still valid (maps in the
XTRAMAPS.PLT file are invalid, for example, if they are on a removable disk
that is not currently mounted, or if you have renamed a directory or folder that is
part of the path to the map).

Also, if you have a CDMAPS folder containing the appropriate files, MARPLOT
will automatically add maps from a LandView compact disc as soon as it
recognizes that such a CD has been inserted.

Thus, you have a number of options for adding MARPLOT maps to your system.
This example explores these options in four sections. The first two sections apply
to using maps taken from a source other than a CD. Later sections discuss using
maps from CDs.

Note: See section 2.4.3 for more information about adding maps to your system.

Copying a map into the MARPLOT folder (directory)

If you have space on the hard disk where you keep MARPLOT itself, and if the
map is one you want to use regularly, it makes sense to keep the map right in the
MARPLOT folder. It’s a simple matter of copying the map folder into the
MARPLOT folder. Macintosh users can do this by dragging the map folder into
the MARPLOT folder using the Finder. Windows users can drag the map
directory (usually on drive A) into the MARPLOT directory (usually on drive C)
using the Explorer or Desktop.
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You have to restart MARPLOT for it to see the new map.

Using Find New Map to find a map on a hard disk

Suppose the map is too big to put on the same hard disk as MARPLOT, and
you’ve copied it to another hard disk and want to keep it there. Or perhaps you
want it on the same disk as MARPLOT, but not in the same folder (you might
want to use the provided XTRAMAPS folder to “hide” it). Perhaps you want to
keep the map on a removable disk, and insert the disk before a MARPLOT
session where that map will be used. In all of these cases, you need to use
MARPLOT’s Find New Map function to show MARPLOT where the map is
located.

First, copy the map to the place you want it. Then start MARPLOT.

From the Map List dialog box, click Find New Map.
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MARPLOT brings up a standard file dialog box. (If a LandView II CD is inserted,
MARPLOT asks if you want to find a map on the CD or in another location. In
this case, we’re looking for a map in another location.)

Use the standard file dialog box to locate the new map folder (directory).
Highlight the NAME.MAP file it contains (on the Macintosh this name may be
suffixed with “;1”). Then click Open (Windows users, click OK).

Back in the Map List dialog box, the new map has been added to the list. At this
point, you can click OK, or click Go to Map to view the added map right away.

MARPLOT keeps the path to the new map in its XTRAMAPS.PLT file. It will
remember the map until you use the Remove button in the Map List dialog box
to remove it.

Using maps on a LandView CD

LandView is a database program for Windows computers that uses MARPLOT
maps. If you have a CD drive, you can use LandView CDs as a source for your
MARPLOT maps. (To read these DOS-formatted CDs, Macintosh users will need
the Foreign File Access system extension and the ISO 9660 File Access file for that
extension. These either came with your computer or are available from Apple
Computer, Inc.)
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Note: In order to take full advantage of MARPLOT’s specialized functions for
LandView CDs, you must have the files COUNTIES.TXT and STATES.TXT in
your MARPLOT folder (directory). These files are distributed with MARPLOT.
Also, you should have in your MARPLOT folder a CDMAPS folder containing 11
files with names of the form “LV2CDM01.TXT.”  Again, these are distributed
with MARPLOT.

When you insert a LandView CD into your CD drive, and if you have the
necessary files in your CDMAPS folder, MARPLOT automatically “loads” all
maps on the CD. (Note: If you insert the CD in the middle of a MARPLOT
session, you have to make MARPLOT redraw its view before it will recognize the
CD.)

The loaded maps draw directly from the CD. Depending on the speed of your
computer and your CD drive, and the size of the area you are viewing, the maps
may or may not draw at an acceptable speed. If accessing maps directly from the
CD is too slow for your purposes, you can download one or more maps to your
hard disk to increase performance, as explained in the next section.

When you bring up the Map List dialog box, you can see all of the CD maps
listed, along with the maps in your MARPLOT folder and the maps referenced in
XTRAMAPS.PLT.
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When the maps from a CD have been loaded, it is often preferable to view the
map list sorted by map folder location instead of by map name. To do this, click
the circle next to the “Folder” label. You can see the maps in your MARPLOT
folder grouped together. Since the LandView II CD is organized hierarchically by
state, maps from the same state also group together.

Once you have inserted a LandView CD and the maps have been loaded, the
maps are ready to use. As you navigate around the map, the various county
maps from the CD will draw (as long as the given TIGER layers are shown).

The map called “STATES” is special. It contains a number of miscellaneous
layers including selected EPA-regulated sites and key geographic features of the
United States such as congressional districts, census tracts and zip code locations.
Each layer on the STATES map covers the area of all the states included on the
given CD. You can see the full list of layers from the STATES map by looking at
the Layer List dialog box. The STATES layers have names in capital letters. See
the documentation that came with your LandView CD for more information
about these layers.

Note: It is best not to download the STATES map to your hard disk because it
contains so many layers, and because each LandView CD has a STATES map,
which can lead to confusion if you try to download more than one.
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Using Find New Map to download a map from a LandView CD

For a number of reasons, you may want to copy maps from a CD onto your hard
disk:

• Most map operations such as drawing, clicking, and searching are faster
when maps are on your hard disk.

• You want to edit the maps to correct errors or add missing features (you
cannot edit maps on a CD).

• You only want to use a few maps from the CD, and don’t want to bother
with the delay when MARPLOT loads the entire CD on startup.

• You have borrowed the LandView CD and want to copy certain maps
before returning it.

Copying or “downloading” maps from a LandView CD involves the use of two
buttons in the Map List dialog box.

Recall that when you insert a LandView CD (and provided you have the
appropriate files in your CDMAPS folder) MARPLOT automatically loads all
maps from the CD into the Map List.

Suppose you want to download the map for Addison County, VT (which is
highlighted in the list above) from the CD to your hard disk.

First you need to remove Addison County from the Map List, since the Map List
has that county located on the CD and you want to copy it to the hard disk. To
do this, highlight the county and click Remove in the Map List. After answering
“OK” to MARPLOT’s warning, we see that the map has been removed from the
list.
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Next, click Find New Map.

MARPLOT recognizes that a LandView CD is present and asks whether you
want to use it or search in another location. Click CD.

MARPLOT then presents you with a list of the states and counties on the CD.
Highlight the name of the state you want in the lefthand list. Then highlight the
name of the county you want in the righthand list. Click Select.

MARPLOT asks whether you would like to use the map on the CD or download
it. Note that MARPLOT displays the size of the map to help you decide where to
download it.
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Generally, it is most straightforward to download the map to your MARPLOT
folder, although if you do not have the space on your MARPLOT disk drive
you’ll have to download it to another drive. Also, if you only want to use the
map periodically, you may want to put it somewhere other than the MARPLOT
folder such as the XTRAMAPS folder.

When you click one of the Download buttons, MARPLOT copies the map files.

Back in the Map List dialog box, the new map is back in the list, but this time it is
located on your hard disk. When the CD is removed, the downloaded map will
still be part of your system. Also, in future MARPLOT sessions using this CD, the
copy of Addison County, VT that you downloaded will be used in preference to
the copy of Addison County on the CD.
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5.2   Searching and the Search Collection

In the guided tour in Chapter 3, you saw how to search for cities, roads,
intersections, and address ranges. In these cases, we were finding map objects by
name. You can use the same techniques to find other objects by name. For
instance, to find the University of Washington in King County, you could search
for objects with names starting with “univ” on the Miscellaneous layer of the
King County map (or simply the “Maps in View” if you are currently looking at
King County).

In this example, instead of searching primarily by name, we will explore the
different mechanisms MARPLOT provides for searching by geographical
distance. We can ask questions like, “How many objects on layer A are within
one mile of this point?” or “Among the objects found in the last search, which
ones fall within this threat-zone?”

The simplest way to search within a certain area or distance in MARPLOT is
simply to drag on the map with the arrow tool. As you drag, you define a region,
either rectangular or circular (you can choose the shape in the Preferences dialog
box). When you release the mouse button, MARPLOT asks which layers you
want to select on (only layers that are currently shown are offered). It then selects
all of the objects from the chosen layers that fall within the defined region. It
includes objects that are partially inside and partially outside of the region.

For instance, the Washington, DC map includes symbol objects on the
Miscellaneous layer representing many of the Federal buildings and national
museums in the area. Suppose we want to find which of these buildings and
museums are within half a mile of the Capitol. We use the Preferences dialog box
to set the arrow selection shape to circle. Then we click on the Capitol and drag
away until the radius of the circle is 0.5 miles, as indicated in the status line at the
bottom of the map window.
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When we release the mouse button, MARPLOT asks which of the visible layers
we want to select on. We check only Miscellaneous and click Select.

MARPLOT selects all of the Miscellaneous objects that fall within the defined
circle, and tells us that 102 objects in all were selected.

MARPLOT found not only the point (symbol) objects, but the other objects on the
Miscellaneous layer that were within the given radius. In this case, the grounds
around the Capitol are represented as many small polygon objects, all named
“landmark,” and one larger polygon object called The Mall.

We can see exactly which objects were selected using the Copy to Search
Collection function in the List menu. This copies all of the objects that are
currently selected on the map into the Search Collection, replacing any previous
Search Collection. As soon as the objects are copied, MARPLOT displays the
Search Collection dialog box.
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To find the location of one of the objects in the Search Collection, we highlight it
in the list and click Show on Map. MARPLOT displays the map with only that
object selected. Although only one object is selected now, the Search Collection is
unchanged; it still contains the 102 found objects.

Now let’s look at some examples of searching by geographic distance using the
Search Criteria dialog box.

The Conrail Railroad passes along the south edge of the Mall. Suppose we want
to identify the government buildings on our map that fall within 800 feet of any
point along this stretch of railroad.
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We can do this by selecting the “Conrail Railroad” object and selecting the Search
item from the List menu. We search for objects that “are within” 800 feet of the
currently selected object (i.e., the railroad object we just selected on the map). We
choose to search on the Miscellaneous layer.
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After a few seconds of computation, MARPLOT displays the results of the search
in the Search Collection. Again, we see several polygons, along with the point
objects we are interested in.

As a final example of searching, suppose we have a database of hospitals in King
County, WA. We want a list of the hospitals that are either in the city of Seattle or
the city of Bellevue, which is just across Lake Washington from Seattle. To find
these hospitals, we can show only the Places layer of the King County map, and
then select both Seattle and Bellevue by clicking on them while holding down the
shift key.
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We can then search for all objects (objects with any name) on the Hospitals layer
that are inside the objects currently selected on the map (i.e., the two city
polygons).

MARPLOT lists the found hospitals in the Search Collection. If we are planning
to use this particular set of hospitals repeatedly, we can avoid having to redo the
search by saving the Search Collection to disk. MARPLOT lets us specify the file
to save into. It is a good idea to keep our saved Search Collections in the
“Searches” folder (directory) that MARPLOT provides explicitly for this purpose
(each user in a multi-user MARPLOT system has his or her own Searches folder).
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During a future MARPLOT session, we can retrieve the saved Search Collection
by selecting Show Search Collection from the List menu, clicking the Load
Collection button, and selecting the saved hospitals file.
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Keep in mind that saving a Search Collection does not save the actual objects
themselves, but only references to the objects. Thus, if you save an object as part
of a Search Collection, and then delete the object from the map, you cannot
recreate the object by loading it from the Search Collection. If you load a Search
Collection containing references to deleted objects, MARPLOT displays a
warning that those references are now invalid.
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5.3   Adding and modifying objects

While some users of MARPLOT will primarily use their maps as is, for viewing
and searching only, many users will want to make modifications and additions.
These can range from minor graphical modifications of pre-existing objects to the
entry of entire databases of geographical information.

This section gives examples of creating and modifying six of the seven types of
MARPLOT objects: points, rectangles, circles, polylines, polygons, and text
labels. Working with the picture objects is demonstrated in section 5.5. Section
5.4 shows how to perform detailed edits on roads, which are a type of polyline
object.

Layer locking and user permission

Any time you are going to be modifying or adding objects, you need to unlock
the layer or layers you will be editing. MARPLOT starts each session with all
layers locked. It is a good practice for you to unlock only one layer at a time,
except in certain cases when two or more layers must be unlocked at the same
time, such as when you are moving objects from one layer to another. You
should relock a layer as soon as you are finished making changes to it. This will
reduce the chance of edit mistakes, such as dragging an object when you
intended only to click on it to select it.

If your MARPLOT system is multi-user, your system administrator has set you
up either with browse-level or edit-level permission. If you have edit-level
permission, you can unlock any layer, and modify any object on that layer on
any of the maps on your system. (Actually, certain layers and certain maps can
be “owned” by another application. All users are restricted in the edits they can
perform on these maps.)  If you have browse-level permission, you can still
unlock any layer, but you can only make modifications and additions to your
personal user’s map. For example, you can unlock the Roads layer, but you will
only be able to add and modify “roads” on your personal map, not on the
TIGER-derived county map(s) that you share with other users of your
MARPLOT system.

If your MARPLOT system is not multi-user, anyone who uses the system has
edit-level permission.

Changing the fill pattern of city polygons

Suppose we want to generate a printout of Prince William County that shows
just the Places layer — the various cities and towns, plus the boundary of the
county itself. When MARPLOT maps are generated from TIGER data, the
translator program assigns a random color and fill pattern to each city/town
polygon. Occasionally, two adjacent towns may be assigned the same color and
fill pattern, making it hard to distinguish them visually. The problem is worse
when dealing with printed maps, since only the fill pattern can distinguish the
polygons if you do not have a color printer.
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Looking at the picture below, we see that the adjacent towns Montclair and Dale
City have both been assigned the same fill pattern.

Let’s change the fill pattern for Dale City to distinguish it more clearly from
Montclair. To do this, we must first unlock the Places layer. We bring up the
Layer List dialog box using the Layer List item in the List menu.

We click on the lock icon for the Places layer to unlock it, and then click OK. If
we did not have edit-level permission, MARPLOT would still unlock the layer,
but would present a note reminding us that we would only be able to make
changes on the Places layer of our personal user’s map, not shared maps like
Prince William County.

Back in the map window, we see that the list of tools along the left edge of the
window has been extended to offer tools for creating objects. Whenever one or
more layer is unlocked, MARPLOT offers these tools. In this case, however, we
are interested in modifying existing objects, not creating new ones.
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We click on the Dale City polygon to select it.

We then select the Object Settings item from the Objects menu. We are presented
with the Object Settings dialog box for Dale City.

Because the Places layer is unlocked, all of the items in this dialog box are
“active,” meaning that we can click on them to set the various attributes of the
object: its name, map and layer, its classifications, its graphical settings, etc. If the
Places layer was not unlocked, or if we only had browse-level permission, this
dialog box would display the same information, but all of the items would be
grayed-out, indicating that we could not change them.
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To change the fill pattern for Dale City, we click on the Fill Pattern pop-up, and
choose one of the striped patterns. We then click OK.

     

The map is redrawn, and we see that Dale City has the new pattern.
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If we zoom into the clump of towns near the center of the county, we find that
there are three adjacent towns that all have the same fill pattern.
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We could use the same method as above to change the pattern of two of the
towns. A short cut is to use the graphical items in the Objects menu. We select
Bull Run, and then select a new pattern for it from the Fill Pattern submenu.

The map is redrawn and the new fill pattern shows. We can do the same thing
for Sudley, picking a different pattern this time.
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When we are done editing the Places layer, we should lock it.

Creating different types of objects

Using the Layer List, let’s unlock the Temporary Layer. We are going to be
making some objects just for demonstration purposes, so the Temporary Layer is
a good place to put them, since they will be deleted automatically when we quit
MARPLOT (we do get a warning and a chance to move the objects to another
layer before quitting, in case we want to keep them after all).

Also, let’s put the Temporary Layer in Show + Names mode, so we can see the
names of the objects we create.

We’ll zoom in to the northern part of Prince William County. Only the Places
layer is shown, so we have a lot of white space to use as our scratch area.

Let’s start by making a symbol (point) object. We select the  symbol tool by
clicking on it. To create a new symbol object, we simply click at the desired
location on the map with this tool.
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MARPLOT immediately brings up the Object Settings dialog box for the new
point object. It assigns the point the default name “untitled.”  It puts the point on
the Temporary Layer, since that is the only unlocked layer. Also, it chooses the
user’s map as the default map for the object. The default graphical settings for
the object are the defaults for the Temporary Layer.
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We set the name of the object by typing in the top item. Let’s also change the
symbol by clicking on the symbol pop-up and dragging to the symbol we want.

We click OK, and we see the new symbol object on the map.



Chapter 5: Examples

114

If we decide the object is not in the correct position, we can move it in one of two
ways. If we know the exact latitude/longitude position of the object, we can set it
using the Position button in the Object Settings dialog box. If we are not
concerned with that degree of precision, however, we can move the object simply
by dragging it with the arrow tool.

     

Creating rectangle and circle objects is straightforward. Remember that rectangle
objects always have horizontal and vertical edges. If you need a rotated
rectangle, you have to use a polygon.

To create a rectangle or circle, drag on the map to define the shape. As with any
object, the Object Settings dialog box pops up to let you set the name, layer, map,
and other attributes. We’ll stick with the Temporary Layer of the User’s map.
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Polylines and polygons are created by clicking at each vertex point. A double-
click indicates the final point.

     

As we saw with the symbol object above, any object can be moved by dragging it
with the arrow tool, or by entering latitude/longitude values in the Object
Settings dialog box. With non-symbol objects, you can also reshape using the
arrow tool. For instance, we can change the shape of the rectangle by dragging its
corner. And we can change the shape of the polygon by dragging one of its
vertex points.
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The final item in the list of tools, , is used to make text label objects. These are
for labeling areas on maps, when the shown names of the individual objects do

not provide sufficient information. When we click with the  tool, we get the
Object Settings dialog box, as usual, but for text objects we are immediately
asked to enter the text.

     

Keep in mind that text label objects scale along with the rest of the map as you
zoom in and out. For instance, if we zoom in closer to the sample text object, the
letters get larger.

As mentioned above, if we try to exit from MARPLOT after having created
objects on the Temporary Layer, we get a warning that those objects will be lost.
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Creating a new layer

Suppose we decide to save some of the objects that we created. We need to move
them to a different layer. In most cases, we would probably already have an
appropriate layer. But in this case, suppose we do not have such a layer and we
want to create a new layer for the objects. Using the Layer List, we click New and
enter a name for the new layer.

The new layer is added to the top of the Layer List, and is unlocked by default.
At this point, we have a new layer, but there are no objects on it on any of our
maps.

Moving objects between layers and maps

You should always think twice before moving objects from one layer to another,
and especially before moving objects from one map to another. The reason for
this is that, when MARPLOT shares information with other programs, objects are
referred to using their layer and map names. For example, a database program
might have a record linked to a MARPLOT object. The database keeps the link,
including the fact that it thinks the linked object is on a certain map and a certain
layer. If the object gets moved to a different layer, and especially if it gets moved
to a different map, there might be trouble later when the database program refers
to the object using its old recorded layer and map.

Therefore, before moving objects between layers and maps, make sure the objects
are not linked. If they are linked but you must move them anyway, you may
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have to reestablish the links after they are moved (the work involved depends on
the particular database you are working with).

In our case, we know the objects are not linked, since we just created them. Let’s
move our objects to the new “sample layer”. We could do this one object at a
time using the Object Settings dialog box. But it is much easier to move them all
at the same time using the Move Objects to Layer item in the Objects menu. First
we select all of the new objects (using shift-click with the arrow tool is one way to
do this). Then we select Move Objects to Layer.

     

We highlight the “sample layer” and click Move. We can confirm the objects
have been moved to the “sample layer” using the Layer List.
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5.4   Editing road segments

MARPLOT maps derived from TIGER data sometimes have features that are
inaccurate, out of date, or missing. In particular, it is not uncommon to find some
problems with objects on the roads layer. These might include missing road
segments, misnamed roads or pieces of roads, or incorrect address or ZIP code
information. For some MARPLOT users, especially those working regularly
within a relatively small region, it is worth the time and effort spent to correct all
or some of these errors.

MARPLOT allows you to edit road objects, just like any other objects. Functions
are provided for performing many types of edits to roads and other polyline
objects: inserting and deleting vertex points, moving vertex points, and setting
attributes on a segment-by-segment basis. There are certain types of edits,
however, that cannot be performed directly in MARPLOT. Instead, it is necessary
to use MARPLOT’s Export and Import functions, along with a text editor. An
example of this advanced type of editing is given in the MARPLOT Technical
Documentation.

Note: If you are making edits to TIGER-derived objects such as roads, please
read about reporting these edits to the Bureau of the Census in section 1.2.11.

Extending a street and making an intersection

The picture below shows Adams St, which can be found in Dale City on the
sample Prince William County map.
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Suppose that since the time the TIGER data on which this map is based was
recorded, Adams St has been extended to the south-east. It now intersects with
Gideon Dr, and continues on to the southeast for 500 feet. We would like to
modify Adams St on our map to show this extension, making sure that the
intersection with Gideon Dr works properly. We would also like the address
ranges of the extension to be set correctly. In particular, the small piece of the
extension that is west of Gideon Dr is the new 2800 block of Adams St. The larger
piece of the extension that is east of Gideon Dr is the new 2700 block of Adams
St.

The work to be done, then, is to add two segments to the Adams St object. The
vertex connecting these two segments should coincide with a vertex of Gideon
St, causing the two streets to intersect.

To start, we unlock the Roads layer using the Layer List dialog box. Whenever
the Roads layer is unlocked, we should be especially careful not to make careless
edits. And we should lock the Roads layer again as soon as we are finished
editing it, as a further safeguard against mistakenly corrupting road data.

Before we begin making changes, we should take a detailed look at the objects
we will be working with. We click along the east-most segment of Adams St.
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We then select the Segment Settings item the Objects menu.

We see that this is the first of the six segments of the street. Thus, in terms of the
segment order, this street goes from east to west. We are going to be adding two
segments to Adams St, so there will be eight segments in the object when we are
done. Since we will be adding segments to the east, our two segments will be
segments 1 and 2 of the new Adams St. The six old segments will be segments 3
through 8.

The Segment Settings dialog box also shows that the addresses on the selected
segment increase from east to west. This makes sense in terms of our planned
extensions, in which addresses decrease as we move farther east.

As a final preparation step, we should click on Gideon Dr to see where its vertex
points lie. In the picture below, we see that Gideon Dr has a vertex pretty much
right in line with the desired extension of Adams St. (If there wasn’t such a
vertex, we could either drag a vertex of Gideon Dr to the desired position, or use
the Insert Vertex at Focus Point menu item to insert a vertex in Gideon Dr exactly
where we want.)

Now we are ready to extend Adams St. The way to create new segments in
MARPLOT is to use the Insert Vertex at Focus Point item in the Vertex submenu
of the Objects menu. But we can only insert a vertex in a pre-existing segment.
How can we create the vertex points of our extension?
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The solution is first to drag the existing endpoint of Adams St to the final
endpoint of the extension.

We have, in effect, just made the 2900 block much longer.

Now we can insert two vertex points to make the two new segments. As shown
in the picture above, the Focus Point has been left sitting at the old endpoint of
Adams St. We use the Insert Vertex at Focus Point item from the Vertex menu.

As shown in the picture below, this inserts a vertex at the location of the old
endpoint. (In the picture, the Focus Point has been moved to the side to show the
new point more clearly.)
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Now we insert another vertex point, this one very close to where Adams St
crosses Gideon Rd. We click at the desired location to place the Focus Point, and
then use Insert Vertex at Focus Point (again, the Focus Point has been shifted in
the final picture to show the new vertex).

     

You’ll notice that we didn’t put the second vertex point right on the intersection
with Gideon Rd, but a little to the southeast. The reason for this is that, even if
we tried to click exactly at the right location, we don’t have the precision at our
computer-screen resolution to place the point so that it coincides exactly with a
vertex point of Gideon Rd. As explained in section 4.6.3, MARPLOT only
considers two roads to intersect if they share a vertex exactly in terms of
latitude/longitude coordinates. If we were to search for intersections of Adams
St at this point, Gideon Rd would not be found.

We need to use the two other items in the Vertex menu to create a true
intersection between Adams St and Gideon Rd (again, see section 4.6.3 for more
information). We click on Gideon Rd to select it, placing the Focus Point close to
the vertex with which Adams St is to intersect.
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Then we select Mark Vertex from the Vertex Menu. This sets the Marked Point at
the vertex of Gideon Dr that was close to the Focus Point (i.e., the point for our
intersection).

Now that we’ve marked the desired point, we click on Adams Rd again, placing
the Focus Point near the vertex point that is supposed to coincide with the
Marked Point.
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Finally, we choose Move Vertex to Marked Point. This causes the vertex of
Adams St that is close to the Focus Point to be shifted so that it coincides exactly
with the Marked Point (which has been set to be equal to the desired point on
Gideon Rd). We can then choose Clear Marked Point from the Marked Point
submenu in the Edit menu.

Now the roads intersect. When we search for intersections of Adams St, Gideon
Dr is found, and vice versa.

It was specified that the extension of Adams St should go 500 feet beyond
Gideon Dr. We can use MARPLOT’s distance tool to measure the distance and
adjust the endpoint as necessary.

Our segments are now complete, except for the address ranges. Recall that we
made these two new segments by inserting points into the (stretched) existing
2900 block of Adams St. By default, MARPLOT assigns the new segments the
same address range as the original segment that was split (this is true for the
other segment attributes as well, such as ZIP code). So we currently have three
segments of Adams St that all have the address range 2900 – 2999.
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To modify the address ranges for the two new segments, we click along the first
segment.

We then choose Segment Settings from the Objects menu and set the address
values for the 2700 block.

Clicking Next brings us to the second segment, where we set the address values
for the 2800 block.
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5.5   Using picture objects

Picture objects are like rectangle objects except, instead of being filled with a
pattern, they are filled with a graphical image. The source for this image is
usually a picture file (PICT file on Macintosh; bitmap or metafile on Windows).
The image can also come from the clipboard, after you copy it from another
application (usually a painting or drawing application).

In some cases, you want the picture to be “geo-referenced”; that is, located in a
position meant to be (or to be very close to) its actual position in the real world.
For instance, the picture might be a detailed drawing of a university campus.
Here, you want to place the picture object so that points on the drawing
correspond as closely as possible to the correct points on the earth. To help you
with this, MARPLOT has a special mechanism for geo-referencing picture
objects.

In other cases, the exact latitude/longitude placement of the picture object is not
as important. For instance, if you want to add a logo or other design to your
map, it is sufficient to drag and stretch the object directly on the map in order to
position it.

Adding a picture object with geo-referencing

Suppose we are working in Seattle. We have the TIGER-derived MARPLOT map
for King County, in which Seattle is located. The University of Washington has
provided us with a detailed picture file of the UW campus. We want to use this
diagram as a MARPLOT picture object, to flesh out the campus details that are
lacking on the given TIGER-derived map.

Looking at the given map, we see that UW is present as a single polygon object
on the Miscellaneous layer.
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As a first step, we can unlock the Miscellaneous layer, and then use the Object
Settings dialog box to set the fill pattern of this polygon to white (i.e., no fill).
Now the polygon appears blank and we are ready to insert the picture object.

      

It makes sense to insert the UW picture object on the Miscellaneous layer. We’ve
already unlocked that layer to alter the UW TIGER polygon. So we can
immediately choose Insert Picture Object from the Edit menu.

We are asked if we want to use an existing map, or make a new map. You will
almost always choose Use Existing Map here. Making New Map would be used
only if the picture to be inserted couldn’t really be called “part” of an already
existing map. In our case, the UW picture is clearly part of the King County map,
so we’ll choose Use Existing Map.
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MARPLOT asks us to select the picture file containing the image for the new
picture object. We find the picture and click Open (OK on Windows).

We are immediately presented with the Object Settings dialog box for the new
picture object. We see the picture displayed in the lower part of the window.
Note that MARPLOT puts the object on the Miscellaneous layer by default, since
that is the only unlocked layer. By default, MARPLOT guesses that we want the
object on the User’s map. In this case, it probably makes more sense to put the
object on the King County map itself (as we have done in the graphic above),
although keeping it on the User’s map may also be a reasonable decision.

At this point, we have the object on the right layer and map, but its size and
position are undefined. If we were to click OK, MARPLOT would guess at the
size and position. We could then drag and stretch the object directly on the map
to get the right size and position. A more precise method, if we know at least one
exact latitude/longitude point on the picture, is to use the Geo-Reference button.
(Note: Even if you do not use the Geo-Reference button when you first insert the
picture, you can use it at any time in the future by simply bringing up the Object
Settings for the picture object.)
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When we click Geo-Reference, we are presented with a special dialog box used
for geo-referencing pictures.

The idea here is to specify the exact size and location of the picture. We do this
by marking two points on the picture. We have to give an exact
latitude/longitude position for the first point. For the second point, we can give
either an exact latitude/longitude position, or the exact distance from the first
point.

Suppose that in our case, the Geography Department at the University, which is
located in the building just to the north of the magnifying glass cursor in the
diagram above, has informed us that the southeast corner of their building is at
longitude 122°17’34’’ west and latitude 47°39’18’’ north. Suppose they also
inform us that the building is 300 feet long, from the north end to the south end.

First, we use the  tool to zoom in on this point and increase our accuracy.

Then, using the  tool, we click on the southeast corner of the Geography
building.
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We are asked to enter the lat/long values corresponding to the point we clicked.

Next, using the  tool we click on the northeast corner of the building.

We don’t know the lat/long of the second point, but we do know the distance
between the two points since we know the length of the building is 300 feet.

We click Distance and enter 300 feet.
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MARPLOT computes the lat/long of the second point based on the distance.
Since we have now specified both points, we click OK to exit the Geo-Reference
Picture dialog box, and OK to exit the Object Setting dialog box.

On the map, we see that the picture has been added to the Miscellaneous layer,
and is in the correct location. If the picture were not in the correct location, it
could be because the lat/long value or distance provided was inaccurate, or
because the picture was not drawn properly to scale. It is also possible the
lat/long value provided was more accurate than the TIGER lat/long values of the
King County map, because it was based on a more accurate model of the shape
of the earth (see section 1.2.11). In this case, we might try to drag and stretch the
object to get it as close as possible to the right size and position.
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Now that the picture is in place, we can lock the Miscellaneous layer. We can
treat the picture as if it’s part of the King County “base map.”  We can zoom in
on it and place other objects on top of it, to mark chemical locations on campus,
for example. It’s important to keep in mind that any objects we place “on” the
university diagram should be on layers that are above the Miscellaneous layer.
Otherwise, the diagram will draw over the objects.

Adding a picture object without geo-referencing

The Western Regional Center (WRC) of the National Oceanic and Atmospheric
Administration (NOAA) is also located in Seattle, on the northwest shore of Lake
Washington. On the TIGER-derived MARPLOT map for King County, the WRC
is not specifically indicated.

Suppose we want to add the NOAA logo to our map to flag this NOAA location.
We have the NOAA logo in a paint file. We can open the file in our paint/draw
application, and copy the image to the clipboard.

In MARPLOT, we unlock the Miscellaneous layer. As with the university
diagram in the previous example, here we’ll place the logo on the Miscellaneous
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layer of the King County map, although it would be reasonable to put it
elsewhere, say on a “Logos” layer of the user’s map.

We choose Insert Picture Object from the Edit menu. Again, we add the picture
to an existing map.

At this point MARPLOT notices the picture on the clipboard and asks if we want
to use that one. We click Clipboard to use the copied picture.

MARPLOT takes the image from the clipboard and brings up the Object Settings
dialog box for the new picture object. MARPLOT assigns a default name to the
object, in this case “PICT 7.”  We’ll clear the name field, so that MARPLOT won’t
display “PICT 7” below the image when it shows names of Miscellaneous
objects.

Also, we move the object to the King County map from the User’s map, which
was MARPLOT’s default guess. Then we click OK.

MARPLOT adds the picture to the map. We did not geo-reference this picture
object, so MARPLOT can only guess at its size and location. By clicking on the
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picture to select it, then dragging it and stretching it at its corners, we can
position and size it as we desire.

The NOAA logo is now an annotation to our King County map.
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5.6   Generating output

The contents of the map window can be printed to your printer or saved as a
standard picture file that can be opened by a painting or drawing application.

Printing

Before you print, you may want to choose Print Setup (Page Setup on Macintosh)
from the File menu, especially if you are printing from MARPLOT for the first
time. Among the standard printing options is the ability to scale the printed
output to something other than 100%. MARPLOT provides its own mechanism
for scaling your output. So, as a rule when printing from MARPLOT, you should
have the system print scaling, the one shown via Print/Page Setup, set to 100%.

When you have the desired image in the map window (keep in mind that any
insets in the map window such as the reference view or scale bar will be included
in the output), choose Print from the File menu. MARPLOT presents a dialog box
where you can specify the size of the printed image.

When the Print dialog box comes up, the values in the “width” and “height”
fields are set to correspond to the current size of the map window. Thus, if you
leave the numeric settings as they are, the printed output will have the same
scale (i.e., will be the same size) as the image on your screen. If you change the
width, height, or scale value, MARPLOT adjusts the other values accordingly,
and recalculates the total number of pages to be printed, shown in the bottom-
right corner of the “Output Size” box.

     

When printing the image, MARPLOT makes full use of each page that is printed.
For instance, in the second picture above the output width is set to 10 inches.
This means that the image that is shown in the map window will be 10 inches
wide, taking up all of the first page and a couple of inches of the second page.
However, MARPLOT will continue to fill out the second page, extending the
printed image both to the east and to the south. Thus, you typically get a bit
more of your map on the printed output than what is shown in the map window.

Checking the first of the two check boxes causes MARPLOT to print only the
objects that are currently selected on the map.

The lower check box is useful if you have a black & white printer and are
printing colored lines. In some cases, when the printer attempt to simulate a
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colored line by drawing it in a gray pattern, it ends up leaving certain segments
of the line blank. Choosing to draw all lines in black corrects this problem.

Saving a picture

The Save As Picture item in the File menu is used to save the image in the map
window to a file. On the Macintosh, this is a standard “PICT” file, which can be
used by many types of applications. On Windows, you can save the image to a
bitmap (BMP) file or a metafile (WMF). Metafiles are often smaller than BMP
files, and have the advantage that certain programs will allow you to edit them
on an object-by-object basis. However, bitmap files are more common and can be
opened with standard programs such as PaintBrush.

When you have the desired image in the map window (keep in mind that any
insets in the map window such as the reference view or scale bar will be included
in the output), choose Save as Picture from the File menu.

On the Macintosh...

MARPLOT gives you the option of changing the size of the saved picture.

As with printing you can choose to save only the selected objects.

The lower check box is used to embed within the picture “comments” that
cause the lines in the picture to be drawn in a hairline pen width. Also,
checking this box draws all filled objects to the picture, followed by all
non-filled objects, regardless of their layer order. Together, these two
factors cause the saved picture to print as it would if the same area were
printed directly by MARPLOT.

When you click Save, you are presented with a standard file dialog box
asking you for the name and folder location of the saved picture file.
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On Windows...

You are presented with a standard file dialog box asking you for the name
and directory location of the saved picture file. Choose the type of file to
be saved from the “Save File of Type:” pop-up.

As with printing you can choose to save only the selected objects.
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5.7   Transferring map data

Section 2.4.4 discusses the two methods that are used to exchange MARPLOT
data between two MARPLOT installations: copying maps and map files, or using
MARPLOT’s import/export functions.

Copying maps and map files

Suppose we have been adding symbols representing the locations of fire
hydrants in Prince William County. Suppose we have been adding the objects to
a layer called Hydrants. And suppose, first, that we have been putting them on
the Prince William county map itself. In this case, when we open the Prince
William County map folder (directory), we find three files that store the fire
hydrant data: HYDRANTS.LYR, HYDRANTS.SUM, and HYDRANTS.OBJ (a file
named HYDRANTS.NNX may also be present if we have used Compact Map
Files recently). If we want to give this fire hydrant data to another MARPLOT
installation that already has the Prince William County map, we need only give
them these three files. They simply drop the three files into their Prince William
County map folder (directory) and, when they start MARPLOT, the new layer is
automatically added to their system and the fire hydrant objects appear.

Our System Their System
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Suppose, on the other hand, that we have not been adding the hydrants to the
Prince William County map itself (and it might well be a better idea not to, since
we might not like to have our data so closely mixed in with the TIGER-derived
map layers). Suppose we have a separate map called Fire Information Map (see
section 2.4.7 for information about creating maps). In addition to the Hydrants
layer, we might have a Past Fires layer, along with some other fire-related layers.
Transferring this data to another MARPLOT installation is very easy. We simply
give them the entire Fire Information Map folder (directory). They can put this
folder directly in their MARPLOT folder, in which case it’s recognized
automatically when they start MARPLOT, or in some other folder, in which case
they have to use Find New Map in the Map List dialog box to identify the new
map. (They would only have to use Find New Map once; they could replace the
entire Fire Information Map with future updates without having to use Find
New Map again.)

Our System Their System
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Using Export and Import

As explained in section 2.4.4, there may be cases where you cannot transfer entire
maps or groups of map files, but must instead explicitly select the objects to be
transferred and export them to an MIE file. The recipient of the data then imports
the MIE file into his or her system.

First, we select the objects on the map that we want to transfer. There are a
number of ways the selection process can take place. If there are only a few
objects, we may just shift-click them with the arrow tool. If there are many, we
might select them in some automated way, such as using MARPLOT’s Search
function, or a search operation in the database to which the objects are linked, if
there is such a database.

When the objects are selected we choose Export from the File menu and specify a
name for the MIE file.
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The recipient of the data opens Prince William County map, chooses Import from
the File menu, and selects the MIE file you created.
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You can see that some fire hydrants (the ones from the MIE file) have been
added, but the pre-existing fire hydrants on the recipient’s map are still intact.

The following diagram summarizes this export/import data transfer. In the
diagram, the X’s and O’s are meant to represent objects on the same layer. The
X’s are being transferred from one system to another.
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6   Quick-help Diagrams

This section contains a number of diagrams that point out the key parts of
MARPLOT’s main displays and dialog boxes.
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Search Criteria

This dialog box is used to find objects according to various criteria.  You can use the five 

pop-up boxes to modify how and where MARPLOT looks for objects.  Many 
combinations are possible.  Below, six set-ups are shown, along with descriptions of what 

each search will find.

Roads on current map starting with “fair”. All objects on the User’s map.

Hospitals and facilities that are inside the 

objects currently selected on the map 

(which might, for instance, represent 

threat zones).

Places (cities and towns) that are within 10 

miles of the Marked Point.

Among the objects found in the previous 

search, only the roads.

On the Shoreline or Water layers, any 

object that has “lake” in its name.
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Search Collection

The Search Collection is a list of objects.  Each time you do a search, the Search Collection is 
filled with the objects that match the criteria you have specified.  You can also fill the Search 
Collection with the selected objects using the Copy to Search Collection menu item.

An alias is an alternative name for an object.  Aliases in the Search Collection are shown in 
italics.  In the example above, James Madison Hwy is an alternative name for US Hwy 15.

Each object in the Search 
Collection is preceded by 

an icon indicating its type:

polyline polygon point (symbol)

rectangle circle picture text label

Show and select all listed objects.

Show and select highlighted object.  Do not change scale.

Show and select highlighted object.  
Change scale to show only area of object.

List intersections of selected object (usually a road).

List address ranges of selected object (usually a road).

Save Search Collection list to text file.

Load Search Collection list from text file.

When the place/map ends with “...” it means the object is primarily in the named place, but 
crosses into other places as well.
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Intersections

This dialog box comes up when you click the Intersections button in the Search 
Collection.

Highlight the two intersecting objects and put the Focus 

Point at the point of intersection.  Do not change scale.

Usually, you are interested in finding the intersections of an object with other objects on 

its same layer, usually to intersect Roads with other Roads.  However, sometimes you 

may want to intersect with other layers.  For instance, you may want to see where a 

road intersects with rivers on the Water layer.  When the “Intersect with all layers” box 

is checked, the list of intersections is recomputed to include objects from all layers that 

intersect with the given object.

NOTE: For the purposes of this dialog box, MARPLOT only considers two polyline 
objects to intersect if they share a vertex exactly.

Also, change the scale to a scale appropriate for 

viewing typical street intersections.



Chapter 6: Quick-help Diagrams

159

Addresses

This dialog box comes up when you click the Addresses button in the Search 
Collection.

Highlight the road and put the Focus Point along the 
segment corresponding to the selected address range.  Do 
not change scale.

Also, change the scale to a scale appropriate for 
viewing typical street address ranges.
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Object Settings

This dialog box comes up when you use the Object Settings menu item with a 
single object selected, or when you double-click on an object.

Click to view/modify the position of the object by latitude/longitude coordinates.

Use items in this box to change type-specific settings for the object.  For 

symbol (point) objects, you can choose the symbol.  For polygon objects, 
you can choose a fill pattern.  For text objects, you can edit the text.  For 
picture objects, you can geo-reference the picture.

Click to change the feature classification or place (city or map 
name).  Both of these settings are used for display purposes only.

Use to move the object from one layer to another.  Use with caution.

Use to move the object from one map to another.  Use with caution.  Note that 
this does not change the position of the object, but may extend map boundaries.

This area shows the user-code of the original creator of the object, and the user-code
of its last modifier, along with the last modification date.  The location code of the
object, if set, indicates the code number of the object’s original location.

Note: Line Width and Line 
Pattern are combined in 
Line Style on Windows.
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Segment Settings

This dialog box comes up when you select an individual polyline object in the map 
window and use the Segment Settings menu item.  It lets you view/modify information 

specific to the segment of the selected object that is closest to the Focus Point.

The values are editable if the object is on an unlocked layer.  Change the address or ZIP 
code values by typing in the boxes.  Use the Set button to change the classification of 
just this segment (not of the entire object; you can set the object’s classification in the 
Object Settings dialog box).

Use the Previous and Next buttons to scan through the segments of the object.
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7   Troubleshooting

MARPLOT does not display the maps/layers I have. I get a blank window or a
window that only shows some of my maps/layers.

Remember that what you see in the map window depends upon (a) the
area you are looking at, (b) the current scale (remember that layers can be
set to show only at certain scales), (c) the order of the layers (layers can
draw over one another) and (d) the maps that are currently in use. If you
are not seeing what you expect, consider each of these factors.

Here are some suggestions:

(a) Use the Go to View item in the View menu to choose the correct view.
If none of the views in the view list are what you want, you can use the
Map List button to go to the Map List dialog box, and then use Go to Map
to see an entire map.

(b) Use the Layer List item in the List menu. Some of the layers you want
may be in Hide mode, or they may be in Range mode and their scale
settings might have them hidden at the current scale.

(c) Again in the Layer List, when the “alphabetical” box is not checked,
you can see the layers in their top-to-bottom order. Higher layers can
draw over lower layers. Use the Move Layer button to change the order.

(d) Use the Map List item in the List menu to see a list of the available
maps. If the map you need is not listed, you should use the Find New
Map button to locate it, or ask your system administrator to install the
map for you. Maps may be unavailable because the disks they are on are
not currently on-line. Finally, a map may be available but not in use, in
which case you can simply put it in use using the Map List dialog box.

MARPLOT is taking too long to draw my map or to perform some other
operation.

You can interrupt most MARPLOT operations by pressing the escape
(ESC) key. If your layer scale ranges are not set appropriately, you may
find that MARPLOT is taking too long to draw because it is drawing too
much detail at zoomed-out scales. If you find that you are pressing ESC
too often, you should change the layer scale ranges using the Layer List
dialog box.
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I’m searching for “E Maple St” in the Search dialog box, but MARPLOT can’t find
it.

Don’t use directional prefixes in the Search dialog box. In this case, you
should just type “maple” and click Search.

I want to make a change to an object, but MARPLOT won’t seem to let me.

To make a change to any object, that object’s layer must be unlocked using
the Layer List dialog box. Also, if your MARPLOT system is multi-user
and your system administrator has set you up with browse-level
permission, you will only be able to make changes to objects on your
personal user’s map.

A while ago I saved a view of a certain area of my map. When I return to the
view, it shows the right “area,” but the “contents” look different than when I
saved it.

When you save a view, MARPLOT remembers the area you were looking
at and what it looked like when it was saved. However, if you save a view
with certain layers shown and return to the view at a time when different
layers are shown, the view may look different. Similarly, it’s possible that
an object that used to be in the view has since been deleted, or that new
objects have been added. If you are bothered by the discrepancy between
the small saved image of the view and its current state, you can always
delete the old view and save it again with its new look.

When I save a view, the small image that MARPLOT uses to represent the
view looks like a black rectangle, not like what I saved.

When MARPLOT “shrinks” the image of your saved view, patterns in the
image may become more dense than they are in the map window. If you
save a view that contains a dotted background pattern, those dots may
become magnified in the shrunken image, and can in fact totally obliterate
it. Thus, when saving a view you should consider first hiding layers (such
as the “Places” layer) that contain objects that create background patterns
in the map window.

Someone used the Administrator menu item and now MARPLOT asks me to
login with a password every time I run it. I want to go back to a single-user
system without passwords.

There are two ways to return to single-user mode. First, if you know the
administrator’s password (see section 2.4.5), you can use that to enter
MARPLOT. Then choose the Administrator menu item and click the Stop
Administration button in the MARPLOT Administrator dialog box.
Another method is to quit MARPLOT, find the USERS directory (folder)
within the MARPLOT directory (folder), and rename it USERSX.
Subsequent uses of MARPLOT will not require passwords.
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I have a “circle” object that looks like an egg. I can only select the object by
clicking at its very top or very bottom.

If desired, you can “fix” a distorted circle by clicking and dragging on one
of its four selection tag handles (the circle’s layer must be unlocked). As
soon as you begin to drag, the object will become a true circle.

One or more of my map files seems to be messed up. I can see certain objects
on the screen but can’t click on them, I don’t see objects that I know are
supposed to be there, or I get error messages when MARPLOT is drawing the
maps.

Under certain unusual circumstances (perhaps due to a “crash” of your
computer), it is possible for MARPLOT’s map files to become corrupted to
various degrees. The best way to avoid problems with corrupted files is to
keep regular backups of your map files. It is sometimes possible to fix
corrupted files by using the Compact Maps item in the File menu. In the
process of compacting the maps, this function reorganizes the map data,
and this reorganization can correct certain errors. However, corrupted
map files are not common, so you should consider other possible reasons
for your problem before trying Compact Maps.
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Glossary

Administrator MARPLOT can run in either “single-user” or “multi-user”
mode. In multi-user mode, one person is designated as the
administrator. The administrator has the capability of giving
other users access to the system by assigning each user a
password.

Focus Point The small, flashing, target-shaped icon that marks the
location of the most recent point of interest on the map.
Every time you click on the map with the arrow tool, the
Focus Point moves to the location of your click. The Focus
Point also changes in response to other operations, such as
when you show an object from the Search Collection on the
map. The latitude/longitude coordinates of the Focus Point
are shown in the upper-left corner of the map window.

Layer A category of objects. Objects are organized into layers so
that you can operate on only certain objects at a given time.
For instance, you might want to search for an object named
“Walden Pond” only on your “Water” layer. Or you might
want to hide your “Roads” layer at a scale when the number
of roads becomes so great that drawing the map takes too
long.

A given layer can contain objects of different types. For
instance, you might have both point and polygon objects on
a “Facilities” layer. The layers are drawn in a certain order,
allowing you to put certain layers “above” others on the
map. You can use the Layer List dialog box to examine and
modify the settings of your layers.

Map A map is a folder (directory) on your disk that contains the
objects for a certain geographical area. A map folder is often
located in the same folder as the MARPLOT application
program, but can be located anywhere on any of your disk
drives. Often, a map covers the area of a single county, but
maps can be much smaller or much larger than that. You can
have any number of maps. It is common for the geographical
areas covered by two different maps to overlap. If you use
MARPLOT to view an area that intersects with more than
one map, all maps in the displayed area are drawn
simultaneously on the screen.
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All of the maps that MARPLOT is aware of are always
“present,” and there is no need to “close” one map before
opening another to view it. However, it is possible to put a
map “out of use” so that it is not drawn on the screen. Use
the Map List dialog box to examine the list of maps.

A map folder (directory) contains a number of layer files. A
layer file contains the objects for the given layer on the given
map.

Marked Point The pink, target-shaped icon that marks a location of interest
to you. You can set and use the Marked Point with the
Marked Point submenu in the View menu, or the Vertex
submenu in the Objects menu.

Object An entity on a map. MARPLOT maps are composed entirely
of collections of objects. A typical map contains thousands of
objects, distributed among several layers.

There are seven types of objects: point (symbol) objects
mark the location of a point with a symbol or dot; rectangle
objects and circle objects mark rectangular and circular
areas; polyline objects, which are sequences of connected
line segments, represent features such as roads and rivers;
polygon objects represent bounded features such as water
bodies and parks; text label objects are used to label maps
with text; picture objects are like rectangle objects that are
filled not with a simple pattern but with the contents of a
picture image.

An object is always on a certain layer and a certain map.
Each object has a number of attributes that you can examine
and change, such as its name, its color, etc. Some attributes,
such as “fill pattern,” are only present in certain types of
objects.

Scale The ratio of the size of a map to the size of the area it
represents. For example, a scale of 1:50000 means one inch
on the map is equal to 50000 inches in the real world.
MARPLOT can also display scales in terms of units (e.g.,
“1 inch = 3.25 miles”) or in terms of the distance represented
by the width and height of the map window.

Note on scale terminology: as you zoom into the map, the
scale becomes larger. As you zoom out, the scale becomes
smaller.
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Search Collection The list of objects resulting from the most recent search
operation, or from copying the selected objects to the Search
Collection.

Segment Polyline and polygon objects are comprised of connected
line segments. Each segment can have a number of
attributes, such as the range of addresses contained in a
certain segment of a road. When a polyline or polygon object
is selected, MARPLOT draws a red dot at each of its vertices.
This makes it possible for you to see how the object is broken
into segments. If the Focus Point lies along one of the object’s
segments, you can use the Segment Settings menu item in
the Objects menu to see the attributes of that segment.
Similarly, when you find an address range from the Search
Collection dialog box, and show it on the map, MARPLOT
indicates the found segment by centering the Focus Point
along it.

In objects derived from TIGER/Line data, some segments
are called “shape” segments. This means that the segment
“inherits” its attribute settings from a neighboring segment.

Sharing The process of MARPLOT communicating with other
applications. Usually these applications are databases that
store information about MARPLOT objects.

User’s Map Each MARPLOT user has a private map on which he or she
can perform any sort of scratch work by creating and editing
MARPLOT objects. In a single-user system, the user’s map is
simply named “User’s Map.”  In a multi-user system, each
user has his or her own user’s map, with names such as
“John’s Map” and “Mary’s Map.”  Users who have browse-
level permission can only add or modify objects on their
user’s map.

Vertex A point defining the shape of a polyline or polygon object.
Each vertex of a polyline or polygon is highlighted with a
red dot when the object is selected.

View The area of the world that is displayed in the map window.
You can change the view by using one of MARPLOT’s
several navigation tools. You can save a view to be returned
to at a later time by giving it a name. You can pick a view to
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be the “entry view,” which MARPLOT will go to
automatically when it is started. You can pick a view to be a
“reference view,” which is displayed in an inset on the map
window, and which shows the current view in reference to a
larger area.
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Appendix 1: Installing MARPLOT® 3.3

This document explains how to install MARPLOT 3.3.

Before you install MARPLOT

Download the Installer
Go to http://www.epa.gov/ceppo/cameo/marplot.htm
Note: The quickest way to obtain MARPLOT is to download it from the website
rather than to wait for the CD to be mailed.  You should order the CD only if you
are unsuccessful at downloading the software.

If you are unable to download Marplot via the web and are using a CD,
Check package contents
You should have received a single compact disk containing an installer for
MARPLOT as well as this manual.

Installing MARPLOT On a Windows 95, 98, or NT PC
Once you have downloaded the installation program or accessed the CD, double-
click the “Marplot.exe” file icon, then follow the directions you’ll see on your
screen.

Installing MARPLOT on a Macintosh
Once you have downloaded the installation program or accessed the CD, double-
click the “Marplot Installer” file.  Click Install after viewing the introductory
screens, and then follow the directions you’ll see on your screen.

Once you have installed MARPLOT, look for a folder called “MARPLOT Folder”
inside the “CAMEO” folder.  Inside the MARPLOT folder, find the “MARPLOT
Fonts” font suitcase, and move it to your closed System Folder.
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Appendix 2: MARPLOT Symbols

Numbers in parentheses represent the symbol’s ASCII value in the MARPLOT
font.

Places

3 school (51) 4 church (52) 5 federal bldg (52)

6 hospital (54) 8 fallout shelter (56) 9 village (57)

: historical site (58) ; archaeol. site (59) = lighthouse (61)

> pier (62) ? platform (63) @ wildlife refuge (64)

Chemistry

B chem. interest (66) C chem. placard (67) D chem. sample (68)

E infectious subst. (69) F acetylene torch (70)

G above-ground tank (71) H chemical drum (72)

I chem. storage (73) J gas cylinders (74) K corrosive (75)

L explosive (76) M flammable (77) N oxidizer (78)

O poison (79) P radioactive hazard (80)

Fire department

Q fire dept. access (81) R sprinkler conn. (82)

S standpipe conn. (83) T fire pump (84)

U fire escape (85) V fire extinguisher (86)

W fire hydrant (87)

Monitoring stations

— monitoring sta. (209) Y tidal station (89)

Z weather station (90)
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Recreation sites

[ camping (91) \ diving area (92) ] national park (93)

^ park (94) _ rec. beach (95) ` rec. fishing (96)

a sport fishing (97)

Industry

b aquaculture (98) c commercial fishing (99)

d factory (100) e logging (101) f mine/quarry (102)

g nuclear power (103) h pipeline (104)

i subsistence fishing (105)

Sensitive biological resources

o coral (111) p mangroves (112)

q submerged veg. (113) r terrestrial plant (114)

s fish (115) t nursery area (116)

u conch/whelk/abalone (117) v crab (118) w lobster (119)

x oyster/clam/mussel (120) y scallop (121) z shrimp (122)

{ squid (123) | alligator/crocodile (124)

} turtle (125) ~ other reptile/amphibian (126)

Ä gull/tern (128) Å pelagic bird (129) Ç raptor (130)

É shorebird (131) Ñ wading bird (132) Ö waterfowl (133)

Ü bear (134) á deer (135)

à dolphin/porpoise (136) â manatee (137) ä sea otter (138)

ã seal (139) å terr. mammal (140) ç whale (141)

é diving bird (142)
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Water/marine

ó underwater outfall (151) ò surface outfall (152)

ô water intake (153) ö water supply (154) ö drain (156)

ù sewer (157) û storm drain (158) ü sump (159)

° channel buoy (161) ¢ channel buoy (162) £ harbor buoy (163)

§ harbor buoy (164) • mooring buoy (165)

¶ anchorage (166) ß marina (167) ® boat launch/ramp (168)

© hoist (169) ´ boom (171) ¨ exposed wreck (172)

rock awash (173) Æ sunken wreck (174)

Ø precautionary area (175)

Communications

radio comm. (183) satellite ground station (184)

telephone (185)

Transportation, services and vehicles

bridge (186) ª gas (187) º police (188)

access (189) æ helicopter (190) ø fire truck (191)

¿ ambulance (192) ¡ heavy equip. (193) ¬ crane (194)

boat trailer (195) ƒ trailer (196) tractor trailer (197)

rail tanker (198) « skimmer (199) » ferry (200)

…USCG boat (201) ~ medium vessel (202)

À small vessel (203) Ãcontainer ship (204) Õ tanker (205)

Œ barge (206) œ airport (207) – railroad crossing (208)

“ state highway (210) ” interstate (211)
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ICS facilities

‚ incident command post (226) „ incident base (227)

‰ camp (228) Â staging area (229)

CAMEO symbols

± ALOHA source point (177)

— ALOHA concentration/dose point (209)

environmentally sensitive area, lower priority (178)

environmentally sensitive area, medium priority (179)

¥ environmentally sensitive area, highest priority (180)

÷ less than 1 hour breakthrough time (214)

’ 1 – 3 hours breakthrough time (213)

more than 3 hours breakthrough time (215)

Miscellaneous

! polyline layer (33) " polygon layer (34)

OSRO (176) µ high voltage (181) handicapped (182)

Logos

) Environmental Protection Agency (41)

* National Oceanic and Atmospheric Administration (42)

+ U.S. Coast Guard (43)

, Genwest Systems (44)

- MARPLOT (45)
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Shapes

‘ place point (212) Ÿ pixel (217) ⁄ dot (218)

circle (219) ‹ filled circle (220) › cross (221)

fi triangle (222) fl filled triangle (223)

‡ square (224) · filled square (225)

Alphabet

Ê (230) Á (231) Ë (232) È (233)

Í (234) Î (235) Ï (236) Ì (237)

Ó (238) Ô (239) (240) Ò (241)

Ú (242) Û (243) Ù (244) ı (245)

ˆ (246) ˜ (247) ¯ (248) ˘ (249)

˙ (250) ˚ (251) ¸ (252) ˝ (253)

˛ (254) ˇ (255)
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Index

A
Adding Maps.....................................................See Maps
Addresses..........................................................See Roads
Administration....................................................5, 12–19
Administrator....................................................16–17, 53
Arrow Tool .............................................83–84, 101, 118

B
Backups.............................................................................13
Browse Level................................See User Permission
Bureau of the Census .....................................................9

C
CAMEO Map..................................................................21
Center on Focus Point..................................................59
Circle Tool...............................................................86, 114
Cities & Towns, searching for...............36–38, 36–38
Clear...................................................................................54
Color...................................................................................81
Compact Map Files.......................................................50
Copy...................................................................................54
Copy to Search Collection..........................................68
Cut ......................................................................................54

D
Database Programs.....................................................4–5
Difference...............................See Make New Polygon
Disk Space..........................See System Requirements
Distance Tool .........................................................85, 125
DRAW INCOMPLETE................................................44

E
Edit Menu.........................................................................54
Edit Views........................................................................60
Entry View.................................................60. See Views
Exchanging Data

examples............................................................139–43
export...........................................................50, 141–43
import..........................................................50, 141–43
MIE files.........................................................18, 48–50
overview..............................................................15–16

Exporting......................................See Exchanging Data

F
File Menu..........................................................................47
Fill Pattern........................................................82, 108–10
Focus Point ..................................43, 44–45, 59, 80, 150

G
Geo-referencing........................................55, 78, 133–35
Go to Lat/Long..............................................................59
Go to Previous View.....................................................59
Go To View......................................................................58

H
Hand Tool ........................................................................84
Help Buttons .....................................................................1
Hiding Objects...............................................See Objects

I
Import.........................................................................48–50
Importing .......................................See Exchaning Data
Infrequently Used Maps....................................15, 146
Insert Picture Object ...............................54–56, 127–35
Insert Vertex at Focus Point..............................80, 121
Insets...........................................................................46–47
Intersections

of polygons......................See Make New Polygon
of roads.........................................................See Roads

L
Labeling Objects............................................See Objects
LandView.......................................................7, 14, 91–96
Latitude..................................................................7, 52, 61
Layer List..........................................................68–73, 153
Layer List Groups..........................................................71
Layer Scale Ranges...........................27–29, 72–73, 154
Layers

creating......................................................................117
introduction to........................................................2–3
list of......................................................................68–73
locking..............................................................106, 151
moving objects to.....................................................80

Legend...........................................................45, 46, 53, 61
Line Width/Pattern/Style .........................................81
Links.................................................................................4, 5
List menu..........................................................................63
Login.................................................See Administration
Longitude..............................................................7, 52, 61

M
Make New Polygon...............................................56–57
Make New Polyline ......................................................57
Map List...............................................73–75, 89–96, 155
Map Window...................................43–47, 150–51, 163
Maps

adding......................................................14–15, 89–96
area .................................................................................2
backing up..................................................................12
copying...............................................................139–40
creating........................................................................18
custom.........................................................................18
introduction to........................................................2–3
list of......................................................................73–75
moving objects to..............................................80–81
structure on disks..................................................146

Mark Vertex.....................................................62, 79, 124
Marked point ..................................61–62, 80, 148, 151
MARPLOT

folder/directory.......................................89–90, 146
fonts.............................................................See Symbol
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introdcution to........................................................1–2
technical documentation.....................................1–2

Memory...............................See System Requirements
MIE.................................................See Exchanging Data
Move Objects to Layer.................................80, 117–18
Move Objects to Map............................................80–81
Move Vertex to Marked Point...................62, 80, 125
Multiple maps...................................................................2
Multi-User Mode..........................See Administration

N
Navigating.......................................................................31
Network, maps on..................................................17–18
North American Datum....................................................8

O
Object Settings...................................76–78, 107–8, 160
Objects

adding & modifying......................................105–18
identification...............................................................4
introduction to............................................................2
labeling..........................................................................6
showing and hiding..................................................6

Objects Menu..................................................................75

P
Page Setup............................................................See Print
Paste ...................................................................................54
Permission.....................................See User Permission
Pictures..See Save As Picture, Insert Picture Object
Polygon Tool..........................................................87, 115
Polyline <-> Polygon....................................................57
Polyline Tool ..........................................................86, 115
Pop-Up Menus ........................................................44–46
Preferences................................................................51–53
Print....................................................................48, 136–37
Print Setup ...........................................................See Print

R
Rectangle Tool.......................................................85, 114
Redraw..............................................................................62
Reference View................................................See Views
Roads

address ranges....................................39–40, 68, 159
intersections of.............................40–41, 67–68, 158
searching for.......................................................38–41

S
Save As Picture.........................................47–48, 137–38
Save Current View........................................................59
Scale

display/format..........................................43, 52, 150
introduction to............................................................5
ranges..................................See Layer Scale Ranges
setting ..........................................................................59

Scale Bar...............................................................46, 52, 61
Search........................................................63–68, 156, 164

Search Collection.......................3, 66–67, 97–104, 157
Segment Settings.................................79, 121, 126, 161
Selected Objects..........................................................4, 44
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